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About This Manual 

How to Use This Manual 

This manual describes the operation of mxGUI for Nova73 
users.  

Use the Table of Contents at the beginning of the manual or 
Index Directory (Page 220) to locate help on a particular topic. 
An Index Directory is provided at the end of the manual. 

You can access more information by registering on the Lawo 
website at http://www.lawo.de. By registering you will be kept 
up to date with the latest news and releases for your product. 
You can also download software updates and documentation. 

Marginal notes  

The following marginal symbols are used to draw your attention 
to: 

 

User Tips – useful tips and short cuts. 

 

Notes - useful points or cross references which apply to an 
operation. 

 

Warning 

Warnings – alert you when an action should always be 
observed. 

 

 

 

http://www.lawo.de/
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Chapter 1: Overview 

mxGUI (Matrix GUI) 

Lawo‟s mxGUI  (Matrix GUI) is a software programme which 
can run the mc2 graphical user interface on an external 
computer. The programme may be run either on or offline with 
any mc2 system (mc256, mc266, mc290) or with a Nova73. This 
user guide describes the operation of mxGUI for Nova73 users. 
Its applications include: 

 Offline Setup - to prepare and save settings ahead of 
an event.  

 Remote Operation - mxGUI can run online by 
connecting to the Nova73 Control System via its control 
network (Ethernet). 

When you start the mxGUI programme, you are asked to 
choose which system you wish to emulate. In Nova73 mode, 
mxGUI accesses only the displays which are relevant to a 
Nova73 routing matrix. These are: 

Display Description 

Signal List control signal routing and user labels. See Page 46. 

Signal Settings adjust I/O parameters and check the system status. See Page 76. 

mx Routing crosspoint control of signal routing. See Page 62. 

mxDSP 
Settings 

control DSP settings on the optional mxDSP cards. See Page 101. 

Downmix control downmix matrix parameters. See Page 114. 

Signal 
Container 

organise and control multi-channel connections using signal containers. 
See Page 142. 

System 
Settings 

set system options. See Page 186. 

Custom 
Functions 

configure user buttons for custom functions. See Page 196. 

Snapshots load, save and manage snapshots for recall of: 

 User Labels and Routing – made from the Signal List display. 

 Signal Routing – made from the Matrix display. 

 IO parameters – made from the Signal Settings display. 

See Page 132. 

Production List load, save and manage productions. Productions store and recall 
everything listed above for a snapshot plus options set within the 
System Settings display. See Page 119. 

File Transfer transfer files between the mxGUI computer and a Nova73 Control 
System. See Page 34. 
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Chapter 2: Installation 

mxGUI Compatibility 

mxGUI may connect to any mc2 system or Nova73 running 
Version 4.6 software or later according to the following table.  

Note that all systems are supported except a stand alone 
Nova73: 

System Router 
Version 

Control 
System 

Control 
System 
Location 

mxGUI 
with 

Rls ≥ 4.6 

mxGUI 
with 

Rls < 4.6 

Nova73 
Standalone 

980/31 or 
980/32 Motorola HD Core Board no no 

Nova 73 Ripper 
980/31 or 
980/32 Intel 1HE Ripper yes no 

Nova73 DSHS 980/32 Intel 1HE Ripper yes no 

Nova73 MKII 980/33 Intel HD Core Board yes no 

mc² 56 980/33 Intel HD Core Board yes no 

mc² 66 classic 
980/31 or 
980/32 Intel inside console yes no 

mc² 66 top1 
980/31 or 
980/32 Intel inside console yes no 

mc² 66 MKII 980/33 Intel HD Core Board yes no 

mc² 90 
980/31 or 
980/32 Intel inside console yes no 

mc² 90 980/33 Intel HD Core Board yes no 

mc² 90 star² 980/33 Intel HD Core Board yes no 
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System Requirements 

Warning 

Please observe the following system requirements: 

To install and run the software, your computer must meet or 
exceed the following requirements: 

 Hardware: 1.5 GHz (required for VirtualBox) 

 Operating System: Windows XP/Vista/Windows7 or 

MAC OS X Snow Leopard 

 RAM:  for XP, 1.5GB RAM  

 for Vista/Windows 7, 2GB RAM 

 for OS X, 2GB RAM 

 (512 MB for mxGUI; rest for OS) 

 Hard Disc:  minimum 200 MB free space 

 Operation: Keyboard and mouse 

 Interface:  Ethernet 10/100Mbit 

Software 

Lawo‟s mxGUI software runs on a “virtual Linux machine” inside 
your computer. This provides the same operating platform as 
on the Nova73 Control System. To achieve this, three separate 
programmes are installed by the mxGUI installer: 

 mxGUI – Lawo‟s application software. 

 Oracle VM VirtualBox – this programme creates the 
“virtual machine” which runs the Linux operating system. 

 Xming X Server – this programme deals with the 
management of TCP/IP ports within the mxGUI 
computer. 

Warning 

Having completed the installation process you should not need 
to open or modify the Oracle VirtualBox or Xming programmes, 
as all settings are automatically dealt with by the mxGUI 
installer. 

Software Licence 

From Version 4.14 onwards, Lawo‟s mxGUI application is free 
of charge and does not require a software licence. 
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Installation 

Please refer to the “mxGUI Installation Manual” for details on 
how to install the software. When installing the mxGUI software, 
please note: 

User defined Folder 

The location of the user defined folder is where the config and 
shared_folder will be stored. You will need to access these 
folders if you wish to copy files via your host operating system 
(e.g. to USB, email, etc.). The default location is shown below: 

Depending on your computer‟s configuration, this location may 
be hidden to normal users. Therefore, you may wish to change 
the folder location so that it can be easily accessed.  
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Uninstalling the Software 

To uninstall mxGUI, use the “Add or Remove Programs” option 
within the Control Panel of your operating system. Remember 
to remove all three programmes for a complete uninstall: 

 mxGUI 

 Oracle VM VirtualBox 

 Xming X Server 

Updating mxGUI 

If you wish to install a new release of mxGUI software, then 
proceed as follows.  

1. Use the “Add or Remove Programs” option within the 
Control Panel of your operating system to remove 
mxGUI. 

Note that it is not necessary to remove the VirtualBox or Xming 
X Server programmes. 

2. Run the new mxGUI installer to re-install mxGUI.  

At the end of the install, the Oracle VirtualBox installer 
automatically opens - cancel the VirtualBox installer as it is not 
necessary to re-install this programme.  

3. Following the installation or re-installation of mxGUI, a 
restart of the computer is advised. 

 

 

 



 
Getting Started 
Starting mxGUI  

mxGUI User Guide for Nova73 V4.14/3 13/ 221 

Chapter 3: Getting Started 

Starting mxGUI 

1. Start the programme, by selecting mxGUI from the 
START menu or clicking on the shortcut icon. 

Note that this is the default file path created during a standard 
install. If you chose a different file path, then proceed 
accordingly. 

The programme automatically launches the Xming X server and 
the Oracle VirtualBox to provide the “virtual Linux machine” 
which will be the platform for the mxGUI application.  

The following window appears while these programmes start 
up; this may take a few seconds: 

Note that if you have a firewall installed on your computer, you 
will need to unblock the firewall access for the Xming X Server 
programme. Once you have authorised the firewall access, you 
shouldn‟t need to deal with this security alert again. 

If you running Windows 7, then you may also be prompted to 
allow changes to your User Account. 

2. Select Yes on any pop-up windows to authorise these 
changes and continue. 
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Once the VirtualBox and Xming have booted, you will see the 
mxGUI launch window, a small window offering system options: 

From here you can choose which system you wish to emulate – 
mc256, mc266, mc290 or Nova73. This ensures that only the 
features relevant to your product are available from the mxGUI 
displays. You will only see the options selected during the 
installation process. In our example, all four mc2 systems are 
available. 

3. Select the Nova73HD option - and click Start to launch 
mxGUI. 

mxGUI boots up and, unless you prepared a cold start (see 
Page 41), will load its warm start data. This returns the system 
to the settings saved when mxGUI was last shutdown. 

The programme is ready to use once you see the Lawo mxGUI 
operating window: 
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Closing mxGUI 

Remember that mxGUI runs on a virtual Linux machine inside 
your computer. Therefore, when running the software, you will 
notice that two windows are open: the mxGUI operating window 
and the virtual machine: 

You can maximise or minimise these windows in the usual 
manner. So, for normal operation, maximise the mxGUI 
operating window to hide the virtual machine. 

To close the mxGUI programme so that the current settings are 
stored as warm start data: 

1. Select Application -> Quit from the main menu bar, or 
click on the close icon at the top right of the display: 

Either operation quits the mxGUI operating window, and exits 
back to the launch options: 
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If you wish you can now restart mxGUI for a different mc2 
system. 

2. Or, click on the VirtualBox close icon to quit the virtual 
machine. 

Note that if you close the Virtual Box window BEFORE closing 
mxGUI, then the system shuts down without storing any warm 
start data: 
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Warm Start and Cold Start Data 

Provided you close mxGUI from the main programme window, 
your latest settings are saved into the warm start data. This 
means that when you restart mxGUI you will get back to exactly 
where you were when you last closed the application (just like 
on a real mc2 or Nova73 system). 

If you wish to cold start mxGUI (to clear out any warm start 
changes) then follow the procedure described on Page 41, or 
close the Virtual Box window as shown above. 

Note also that the complete “Local Control System”, including 
productions, warm start data, cold start data and so on, is 
stored within the config folder on the mxGUI computer: 

You should not need to access this folder, as all files can be 
transferred using the File Transfer display. However, make 
sure you don‟t edit or delete the config folder contents, 
otherwise you may edit or delete the mxGUI control system! 
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The mxGUI Operating Window 

The mxGUI operating window looks identical to the console GUI 
on mc2 consoles. When operating in Nova73 mode, only 
displays and features relevant to a stand-alone Nova matrix are 
supported.  

The operating window is divided into four distinct areas: 

Main Menus 

 Page – access to the mxGUI displays. 

 Window -> Signal Container Parameters and Signal 
Container Presets - opens pop-up windows for defining 
signal container parameters and presets, see Page 142. 

 Settings -> Connection - opens the Connection pop-up 
which is used to connect to a real Nova73 system in 
order to work online. See Page 30. 

 Application -> Quit – quits the mxGUI application. 

 ? -> Info – opens the info pop-up window opposite and 
shows the release version of the mxGUI software and 
Lawo service contact details. 
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Title Bar 

The title bar contains elements which are always visible: 

 Next/Previous Page buttons 

These buttons work just like the Forward and Back buttons on a 
web browser.  

For example, if you have viewed the DSP Configuration, then 
the Snapshots list, and then the Main display, you can use the 
previous Page button to step backwards through this sequence 
of displays. This can be much quicker than reselecting each 
display from the Page menu. 

The last 16 pages viewed are stored. If you reach the first or 
last page in the sequence, then the button turns grey indicating 
no further selections are available. 

 The Time / Integrated Loudness Display 

The middle of the title bar can show one of the following: 

 Timecode – either Local Time (15:09:04), Timecode 
or Offset Timecode. 

 Integrated Loudness – of a particular summing 
channel (in LUFS). Not relevant to the Nova73. 

Click to select an option, and the relevant sub options appear. 

 Information 

 The title of the selected display – Signal List. 

 The name of the active production – production0004 - 
and the current snapshot if loaded – snapshot0001. 

 The LAWO logo. 

 Warnings 

You may also see the following: 

 A yellow hazard warning flag, if there is a problem with 
any aspect of the system status - see Page 76 for 
details. 
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GUI Displays 

The main part of the operating window is used to open different 
displays for signal routing, production management, snapshots, 
system settings, etc.  

Status Bar 

The status bar provides feedback on the progress of operations 
like loading or saving a production. In addition, it shows the 
connection status of mxGUI: 

Online/Offline Status 

mxGUI normally opens in offline mode: 

 

When offline, mxGUI is connected to the “local host”. This 
means that data is being stored within the “Local Control 
System”, i.e. on your computer. 

When mxGUI operates online, the status bar shows the IP 
address of the connected host: 
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Operating Principles 

Whether you are using mxGUI to prepare an offline setup or 
control functions online, you need to know how to control 
settings using the mouse and keyboard on your computer.  

Changing Display 

1. Select the Page main menu to access all of the 
available mxGUI displays: 

A brief description of each display appears when you hover 
over its title. This can be a good way of finding the right display 
when you are new to the system. 

You can also click on the next and previous Page buttons to 
quickly step through the last few pages viewed (up to 16): 

As an alternative to mouse operation, you can use your 
keyboard to open a particular display or menu: 

2. Press ALT + P to open the Page menu. 

3. Then press an underlined letter to select a display – for 
example, S to open Signals, M to open Matrix, etc. 
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Dedicated Screen Buttons 

For many functions, you will find dedicated screen buttons: 

1. Screen buttons are always beveled with white text – for 
example, New, Save and Save Partial within the 
Snapshots display: 

Right-click Operations 

Other operations may be „hidden‟ and become available once 
you right-click on a selection: 

1. For example, right-click on a snapshot in the Snapshots 
display: 

You can now Load, Update, Protect or Delete the snapshot: 

2. Right-click on a source in the Signal List: 

You now have access to a variety of source options: 
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Naming Operations 

Use your keyboard to name display entries, such as a 
snapshot, production or signal label: 

1. Make your selection – e.g. select a snapshot. 

2. And do one of the following: 

 Click once on the snapshot name – all the existing text 
is selected (white) so that when you type you will 
automatically overwrite the existing name: 

 Or, click twice to edit the existing name – a cursor 
appears at the end of the text (black) allowing you to 
easily append or modify the old name. 

3. When you have finished, press Enter to confirm the new 
name. 

4. Or, if you make a mistake and want to exit without 
making any changes, press Esc. 

Note that if you right-select a text field, you will access Cut, 
Copy, Paste, Delete and Select All: 

Use these options to copy and paste text from one field to 
another – for example, to copy and paste snapshot memo text. 

You can also use CTRL+C or CTRL+V on the keyboard to copy 
and paste selections. 
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Changing Focus 

If you like working with keyboard shortcuts, then you can also 
use the keyboard to change the focus of the display: 

1. Press TAB or Shift+TAB to change the focus area – for 
example, to move from the list of Snapshots to Folders 
on the Snapshots display: 

Note that TAB cycles around the display in a clockwise manner, 
and Shift+TAB in an anti-clockwise manner.  

2. Then use the Up and Down keyboard buttons to step 
through the entries in the list. 
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Adjusting Parameter Values 

In displays such as the System Settings display, you can 
adjust parameter values as follows. For example, to adjust the 
Backup Snapshots: 

1. Click on the arrows beside the value: 

2. Or, focus on a value – either click on it, or press TAB or 
Shift+TAB on the keyboard – and: 

 Press the Up and Down keyboard arrow buttons. 

 Type in a new value. 

 Use the mouse wheel to increment or decrement the 
value. 
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Resizing, Reordering, etc. 

You can resize a display area by clicking and dragging the grey 
separator bar – for example, to widen the Folders list in the 
Snapshots display, position the cursor above the grey 
separator bar, then click and hold while dragging to the right; 
the Folders and Snapshots windows resize accordingly. Note 
that if there is no grey separator bar, then resizing is not 
possible. 

You can also change the order of columns within a list – for 
example, to move the padlock (protection) column, position the 
cursor above the column title, then click and hold while 
dragging the column to the left or to the right. Release the 
mouse button when you are happy with the new position of the 
column. 

Note that any changes you make to window sizes and list 
orders will be reset after a restart. 

If information within a window is hidden, then left/right or 
up/down scroll bars will automatically appear. Select a scroll bar 
at the bottom to scroll left/right or up/down. 
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The AdminHD Configuration 

If this is the first time you have started the mxGUI programme, 
then mxGUI is running a default AdminHD configuration 
installed by the mxGUI installer. 

The configuration is an essential part of any mc2 and Nova73 
system, and configures the system‟s hardware and settings 
such as the sampling frequency of the HD Core and 
organisation of signals within the Signal List display. This 
configuration can only be adjusted from a programme called 
AdminHD; mxGUI cannot change the configuration. 

Note that the default configuration is very basic and is provided 
so that you can play around with the mxGUI interface without 
requiring access to a real Nova73 system. 

You can view the default hardware configuration by selecting 
the Signal Settings display from the Page menu: 

The System and its sub components are marked with red 
attention flags because we are running mxGUI offline. 

If you wish to prepare settings for a real system, then it is 
important that the AdminHD configuration running on mxGUI 
matches that of the final Nova73 system. So first transfer the 
configuration from the Nova73 you wish to configure. See Page 
38 for details. 
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Chapter 4: Online Operation 

Overview 

When operating online, the mxGUI computer talks to a real 
Nova73 Control System via its control network (Ethernet). In 
this mode, mxGUI is simply acting as a remote control. All data 
(productions, snapshots, configuration files, etc.) is being read 
from and stored to the Nova73‟s Control System.  

Network Connection 

The mxGUI computer must be connected to the ETHERNET 
port of the control system. The control system location varies 
depending on your product (see the table below). 

Note that all systems are supported except a stand alone 
Nova73: 

System Router 
Version 

Control 
System 

Control 
System 
Location 

mxGUI 
with 

Rls ≥ 4.6 

mxGUI 
with 

Rls < 4.6 

Nova73 
Standalone 

980/31 or 
980/32 Motorola HD Core Board no no 

Nova 73 Ripper 
980/31 or 
980/32 Intel 1HE Ripper yes no 

Nova73 DSHS 980/32 Intel 1HE Ripper yes no 

Nova73 MKII 980/33 Intel HD Core Board yes no 

mc² 56 980/33 Intel HD Core Board yes no 

mc² 66 classic 
980/31 or 
980/32 Intel inside console yes no 

mc² 66 top1 
980/31 or 
980/32 Intel inside console yes no 

mc² 66 MKII 980/33 Intel HD Core Board yes no 

mc² 90 
980/31 or 
980/32 Intel inside console yes no 

mc² 90 980/33 Intel HD Core Board yes no 

mc² 90 star² 980/33 Intel HD Core Board yes no 

For a direct connection to a single computer, you will need a 
crossed network cable (STP-CAT 5 with RJ45 connectors on 
both sides). 

For connection to multiple computers via a network switch, use 
a straight (1:1) network cable. 

Note that you must use a network switch (included with the 
system) and NOT a Hub. 

Depending on the number of network connections, one 
mc2/Nova73 system is able to support up to 16 mxGUI clients 
simultaneously. 
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TCP/IP Configuration 

To establish communication between the devices, you will need 
to configure the TCP/IP settings for your computer‟s Network 
Interface card.  

You can find information on configuring TCP/IP settings within 
Windows from www.microsoft.com. 

For a direct connection, set the IP Address and Subnet Mask as 
follows: 

IP Address 

The IP Address of your computer‟s Network Interface card must 
be unique, and set within the same range as that of the system. 

Note that depending on your Lawo product, the default TCP/IP 
address of the system will vary: 

 Nova73 – HD Core Router Module = 192.168.102.1 

 Nova73 DSHS - matrix control server = 192.168.102.1 

 mc256 – the console‟s control system = 192.168.102.56 

 mc266 – the console‟s control system = 192.168.102.65 

 mc290 – the console‟s control system = 192.168.102.90 

So, for example, if connecting to a mc266 control system set 
your computer‟s IP Address to say 192.168.102.69. 

Take care when setting the IP address of the system. If there is 
an IP conflict within the network, then the Nova73 or mc2 
system may not operate correctly. 

Note that the Local Host IP address of the mxGUI control 
system is always 192.168.56.101. You will need to know this 
address if you wish to restart the mxGUI Local Host or transfer 
configuration files using AdminHD. 

Subnet Mask  

The Subnet Mask of your computer‟s Network Interface card 
should be identical to that of the system. For all products, the 
default Subnet Mask is 255.255.255.0. 

In a networked installation, it is likely that you will be connecting 
via an Ethernet switch, so please consult your network 
administrator for further details. 

 

 

http://www.microsoft.com/


 
Online Operation 
Getting Online  

30/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Getting Online 

To test the connection and put mxGUI online: 

1. Select Settings -> Connection from the main menus. 

The Connection pop-up window appears: 

If this is the first time you have used the Connection window, 
then it will be blank. This window will eventually list all the 
systems which mxGUI can connect to, each with a Name, 
Primary IP address (main control system), Secondary IP 
address (redundant control system) and connection Status. 

2. Click on New to create a new connection. 

A generic host control system is added to the connections list: 

3. Click on New host 1 to enter a name for this system – in 
our example, we have chosen Studio 1 (mc266). 

4. Then enter the Primary IP address of the main control 
system – for example: 

The connection is now prepared and you are ready to go online. 
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Note that you can prepare several connections for systems 
which you may wish to connect to at a later date. Our example 
below shows three different mc2 connections, all currently 
offline: 

If the console does NOT have a redundant control system, then 
you only need enter the Primary IP address. 

If there is a redundant control system, then the Secondary IP 
address must also be entered. This is always 1 above the 
Primary IP. So, for example, if the Primary IP address is 
192.168.102.65, enter 102.168.102.66 for the Secondary IP. 

5. To connect to one of the systems in the list, right-click 
on its entry and select Connect: 

The mxGUI computer will now attempt to connect to the 
selected mc2 system. 

 If the connection is successful, then the Status column 
updates to show the “plugged in” icon. 

 If the connection fails, then the Status remains as 
“unplugged”. Check your network connections and 
TCP/IP settings. 

6. Having connected to the mc2 system you can minimise 
the Connection window. 

Notice that the status bar at the bottom of all mxGUI displays 
now shows the IP address of the connected host: 
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Remote Operation 

You can now use the mxGUI displays to view or change 
settings on the online system. Please refer to Chapter 6 
onwards for details on each display. 

Remember that while operating online, mxGUI is changing, 
saving and updating data on the active Control System. So, 
make sure any other operators are aware you are online! 

Disconnecting mxGUI 

To disconnect mxGUI from the mc2/Nova73 system: 

1. Maximise or open the Settings -> Connection window. 

2. Select the online system, right-click and choose 
Disconnect. 

mxGUI is disconnected from the mc2 control system and the 
Status of the Connection returns to is “unplugged” state: 

Note that connecting mxGUI to a different system automatically 
cancels any existing online connections. 
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Chapter 5: Offline Setup 

Overview 

When running offline, the mxGUI computer acts as just another 
mc2/Nova73 system – called the “Local Control System”.  
Settings are stored on the mxGUI computer by saving 
productions from the Productions display. Once saved, files 
can be transferred back to an online mc2/Nova73 system using 
the File Transfer display. 

What Can be Prepared Offline? 

The mxGUI Local Control System can save: 

 Productions and Snapshots - from the Snapshots and 
Productions displays. 

 Custom Function Assignments – the mapping of user 
buttons and other custom function assignments can be 
edited from the Custom Functions display. 

Remember to save or update a production to store new 
snapshots or folders. See Chapter 7 for details. 

Where are these Files Stored? 

Open the File Transfer display to locate these files: 

 Active Production – the active production can be 
opened to access individual snapshot folders and 
snapshots. (Automation is not relevant for Nova73). 

 Productions – contains all zipped productions; these 
can be transferred as a complete file. 

 Presets – not relevant for Nova73  

(on mc2 consoles, presets are used to store console channel 
settings such as EQ, Dynamics, etc.). 

 Configuration – contains all configuration data.  

The Custom Template Instances folder stores assignments 
made from the Custom Functions display. 

Note that mxGUI cannot edit the Core Configuration or Signal 
List Configuration. You must use AdminHD for this purpose. 
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The File Transfer Display 

The File Transfer display allows you to transfer Productions, 
Snapshots and Configuration files between the Local Control 
System (your mxGUI computer) and an online Control System 
(Nova73). You might use this display to: 

 Transfer a configuration to mxGUI. This allows you to 
prepare settings offline knowing that the configuration 
data matches that of the final system. 

 Transfer offline setups (productions, snapshots) back to 
a Nova73 system. 

 Transfer files to the mxGUI shared_folder – files stored 
here can be accessed by your host operating system 
and therefore copied to USB, emailed to another user, 
etc. 

1. Select Page -> Production -> File Transfer to open the 
display: 

The display is divided into two halves:  

 Local Control System - on the left you are always 
viewing files or directories on the mxGUI computer. 

 Online Control System - on the right you can view files 
or directories on any online system plus the shared 
folder (host operating system shared folder). 

Note that the Shared Folder (Host OS) is represented on both 
sides of the display so that it can accept files from the Local 
Control System (your offline mxGUI) or an online system. 

In the example above we are connected to a mc266 Control 
System (online). Note that if you open the display offline, the 
only folder on the right of the display is the Shared Folder. 
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The method of operation is very similar to the File display on 
the mc2 consoles: 

2. Open or close directories by double-clicking on the 
directory name (or click on the arrow beside the 
directory name).  

Within the Local or online Control System, data is structured as 
follows: 

 Active Production – contains all data in the active 
production. The active production can be transferred in 
full, or opened in order to select individual elements 
such as a folder or snapshot. 

 Productions – contains all other productions. These are 
zipped files which cannot be opened. They can be 
transferred as a complete file, and then unzipped by 
loading the production to access their individual 
elements. 

 Presets – contains presets (not relevant on Nova73). 

 Configuration – contains all configuration data (Core 
Configuration, Signal List Configuration and Custom 
Template Instances).  

3. Having selected a source and a valid destination, right-
click on the source file to select Transfer: 

Note that files can be transferred from left to right or right to left. 

Also note that each file or folder is clearly marked with its Type 
– e.g. production, snapshot, etc. This is important as files can 
only be transferred to a valid destination. For example, you 
cannot transfer a snapshot into the Preset directory! 
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The Shared Folder 

The contents of the Shared Folder can be accessed from the 
File Transfer display, and outside mxGUI from your host 
operating system. You should use the Shared Folder to 
organise files or transfer files externally (e.g. to USB or email). 

Within your host operating system, the default location for the 
Shared_Folder is shown below: 

Note that depending on your computer‟s configuration, this 
location may be hidden. If you have trouble locating the 
mxGUI_shares folder, then please contact your system 
administrator. 

You can create sub folders and manage files from your host 
operating system. Alternatively, you can use the File Transfer 
display within mxGUI as follows: 

Creating Sub Folders 

1. Right-click on the Shared Folder and select New 
Folder: 

A new folder is added with a generic name. 

2. Type to rename the folder. 

Note that you can create folders within folders simply by right-
clicking on the sub folder name. 
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Deleting Files or Folders 

Note that for safety you cannot delete productions, snapshots, 
configuration files, etc. from the File Transfer display. 
However, you can delete files or folder from the Shared Folder: 

1. Right-click on the file or sub folder and select Delete. 

2. Select OK to confirm. 

The file or folder is deleted from the Shared Folder. 

For more examples of using the File Transfer display to create 
an offline setup, see Page 38.  

Organising Your Files 

If you are going to use mxGUI to prepare settings for a range of 
different Nova73 systems, then it is important to organise your 
mxGUI files carefully. The best approach is to create folders 
within the Shared Folder: 

In this example, we have created a folder for a number of mc2 
studios. Each folder stores all the productions and the 
configuration (complete_config) for the system. This keeps all 
relevant files together making it easy to reset mxGUI for each 
studio‟s configuration/productions. 

 



 
Offline Setup 
Preparing a Production Offline  

38/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Preparing a Production Offline 

In order to prepare a production offline, it is important that the 
configuration stored on the Local Control System matches that 
of the final Nova73 system. 

The best way to achieve this is to import the configuration from 
the system you are going to work on. Once imported, you can 
be sure that the productions you create will load in full on the 
Nova73 system.  

For a fail safe approach these are the steps you should follow: 

 Transfer the Nova73 configuration to the mxGUI Shared 
Folder. 

 Change the configuration of the Local Control System. 
This ensures that the configuration data running on 
mxGUI matches that of the actual Nova73 system. 

 Prepare your settings offline. 

 Save settings by saving a production and/or snapshots. 

 Transfer the production back to the Nova73. 

Transferring the Configuration 

The complete configuration set for a Nova73 system contains 
two individual components: 

 Core Configuration – this file defines the HD 
Core/DALLIS System and its signal parameters 
(config.tcl). 

 Signal List Configuration – this file defines the 
Directories, Subdirectories, Signal Names and Labels of 
the Signal List (gui_config.tcl). 

For simplicity, all components can be zipped and transferred as 
a single file - called the complete_config – using the File 
Transfer display. 

1. Make sure mxGUI is running the Nova73 emulation, and 
open an online connection as described on Page 30. 

2. Select Page -> Production -> File Transfer to open the 
File Transfer display. 

3. Select a location within the Shared Folder (on the left) 
as your destination. 

4. Then right-click on the system‟s Configuration directory 
(on the right) and choose Transfer: 
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All the configuration files are zipped and transferred to the 
mxGUI Shared Folder as a single file - complete_config. 

Note that you can transfer the configuration directly into the 
Local Control System‟s Configuration folder. However, this will 
overwrite the existing mxGUI configuration without any backup.  

We recommend copying the complete_config to the Shared 
Folder first so that you have a copy of the file. By storing the 
complete_config in a folder, you can keep the configuration 
and productions together. 

While you are connected to the online system, you may wish to 
copy any useful productions to the Shared Folder. By loading 
an existing production, you can tweak existing settings rather 
than having to build your offline setup from scratch. 

If you do not have network access to the system you wish to 
configure, then ask for the complete_config and any default 
productions to be sent to you (e.g. via email). Copy these into 
the Shared Folder using your host operating system. 
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Changing the mxGUI Configuration 

Having copied the configuration from the online system, you 
can now disconnect and import the complete_config to the 
Local Control System. 

1. Disconnect the online system from the Settings -> 
Connection window. 

2. From the File Transfer display, select the Local Control 
System‟s Configuration folder (on the left). 

3. Locate the complete_config file you wish to import (on 
the right), right-click and choose Transfer: 

A Warning pop-up appears: 

Warning 

Selecting OK will overwrite the configuration of the mxGUI 
control system. If you wish to backup the existing configuration, 
do this first by transferring Configuration to the Shared Folder. 

4. Select OK to continue. 

The configuration is transferred. 

 

 

 



 
Offline Setup 

Preparing a Production Offline  

mxGUI User Guide for Nova73 V4.14/3 41/ 221 

You now need to cold start mxGUI before the new configuration 
data takes affect. To do this: 

1. Select the System -> System Settings display. 

2. And select the Global topic: 

3. Enable the Prepare Coldstart option. 

This prepares mxGUI so that on the next restart it will perform a 
cold start rather than warm starting from the current 
configuration. 

4. Close mxGUI: select Application -> Quit: 

5. Then restart in Nova73HD mode. 

When mxGUI starts up, you will be running the new 
configuration. You can check this by looking at the Directories 
and Subdirectories within the Signal List and/or the HD Core 
configuration in the Signal Settings display. 
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Preparing Settings 

You can now use the mxGUI displays to view or change 
settings offline. Please refer to Chapter 6 onwards for details on 
each display. 

If you imported some productions from the online system, then 
copy these into the Productions folder of the Local Control 
System using the File Transfer display. You can then load a 
production, from the Productions display, and use this as the 
starting point for your offline setup. 

Saving Settings 

Settings must be saved into a production from the Productions 
display.  

To create multiple setups within one production, use snapshots.  

For details on snapshots or productions, see Chapter 7. 
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Transferring the Production to the 
Nova73 

Having saved the production, it can be transferred back to the 
Nova73 using the File Transfer display. 

1. Make sure mxGUI is running the Nova73HD emulation, 
and open an online connection as described on Page 
30. 

2. Select Page -> Production -> File Transfer to open the 
File Transfer display. 

3. Select the online system‟s Productions folder as the 
destination (on the right). 

4. Then on the left, right-click on the production you wish to 
import and choose Transfer. 

The production is copied to the online Control System: 

Note that you can transfer any type of file: productions, folders 
or snapshots to the online control system. Each file or folder is 
clearly marked with its Type – e.g. production, snapshot, etc. 
This is important as files can only be transferred to a valid 
destination. For example, you cannot transfer a snapshot into 
the Production directory! 

Now load the imported production: 

1. Select Page -> Production -> Productions List to open 
the Productions display. 

2. Select the production, right-click and select Load. 

The production is loaded, and the title bar shows the name of 
the active production – e.g. Football: 

For additional confirmation, watch the status bar and you will 
see a loading… message indicating that production data is 
being loaded. 

Your setup is recalled! 

 

 

 



 
Offline Setup 
Backing up Your Offline Setups  

44/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Backing up Your Offline Setups 

It is a good idea to keep a copy of the production in the mxGUI 
Shared Folder. This ensures that you keep a backup of 
everything needed for this offline setup: the complete_config, 
production, etc: 

Important Notes 

A production created offline will only load completely if: 

 The configuration running on mxGUI matches that of the 
online system. Always check that you have the latest 
configuration from the control system. 

 mxGUI is running the correct mc2/Nova73 emulation. 

Also note: 

When you change the configuration of mxGUI, all other folders 
– Active Production, Productions and Presets – remain 
intact. This means that you will end up with a mixture of 
productions on the mxGUI Local Control System.  

We recommend keeping a backup of all files within the shared 
folder. Create a sub folder for each mc2 system so that you can 
store all configuration data and productions together: 

This way you will know which productions match which 
configuration in a few weeks time! 
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Chapter 6: Signal Routing/Settings 

Introduction 

In this chapter we will cover the operation of the Signal List, 
mx Routing, Signal Settings, mxDSP Settings and Downmix 
displays.  

Input and Output routing can be handled from either the Signal 
List or mx Routing (Matrix) displays. The Signal List presents 
lists of Sources and Destinations, whereas the mx Routing 
display provides a crosspoint overview. You can use either 
display to view or change signal routing. In addition, the mx 
Routing display can be used to create partial snapshots for 
recalling selective routes. 

Input and output parameters such as gain, sample rate 
conversion, etc. are handled from the Signal Settings display. 
In addition, the Signal Settings display provides graphical 
feedback on system components, and serves as a system 
diagnostics tool. 

If your system is fitted with one or more mxDSP cards 
(optional), then settings within each DSP chain can be 
controlled from the mxDSP Settings display. 

If your system is configured with downmix DSP resources 
(optional), then the matrix can be controlled from the Downmix 
display. 

Note that these displays are identical to those found on a mc2 
console GUI. Therefore, not all features on every display are 
relevant to a stand-alone Nova73. For more information on mc2 
console features, please refer to the mc266 Operators Manual. 
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The Signal List Display 

1. Select Page -> Signals -> Lists to view this display: 

The Signal List is used to view and make connections from 
Sources on the left to Destinations on the right. In order to 
keep the list manageable, sources and destinations are divided 
into Directories and Subdirectories.  

Depending on the AdminHD configuration of your system, you 
may have different directory and subdirectory names from our 
example. 

If a source or destination is connected, then you will see a red 
and white cross in the connection column. In addition, if the 
source and destination are both in view, then a link appears to 
show the connection.  

You can interrogate all the routes to or from a particular source 
or destination using the Locate source or Show destinations 
of source functions, see Page 51. 
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The columns beside each signal display the following 
information: 

 Connection – a red and white cross appears when a 
source or destination is connected. If a destination is 
protected, then you will see a padlock icon, see Page 
59. 

 Surround – not relevant for Nova73. 

 Stereo – interlocking red and green circles appear when 
a source or destination is stereo. 

 Unavailable – a warning symbol appears beside signals 
which are not available, see Page 57. 

 Name – this is the system name for the signal (defined 
by the AdminHD configuration). 

 Label – this is the user label for the signal. You can 
rename signal labels from this column, see Page 54. 

 I – indicates if a signal is Isolated from snapshot recall, 
see Page 58. 

 T – not relevant for Nova73. 

 S/I - indicates „Shared‟ or „Imported‟ sources within a 
networked installation. 

If information within a window is hidden, then left/right or 
up/down scroll bars will automatically appear. Note that you can 
resize the Directory, Subdirectory and Signal List windows or 
exchange columns to help view important columns. 
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Routing a Source to a Destination 

To make a route using the Signal List display: 

1. Select the source you wish to connect – select a 
directory, subdirectory and then a signal. 

2. Next, select the destination in a similar fashion: 

3. Then select Connect to make the route.  

The Signal List updates with a line between the source and 
destination showing the connection: 

If you want to undo an existing route: 

4. Select the destination and then Disconnect. 

The line between the source and destination disappears from 
the Signal List display. 

Note that if you route a source to a connected destination, then 
the previous source assignment is replaced; you don‟t have to 
disconnect the destination to assign a new source. 
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Routing to Multiple Destinations 

To route a range of sources to a range of destinations, use the 
„step forward‟ mode as follows: 

1. Select the first source you wish to assign – for example, 
Mic 1 – and the first destination. 

Your selected source and destination are highlighted in black: 

2. BEFORE you select CONNECT, select the Step mode 
option. 

3. Now select CONNECT. 

The first route is made and the source and destination 
selections automatically step down to the next entries in the list: 
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4. Continue selecting CONNECT until all of your sources 
are connected to your destinations. 

As you step down through the list, note the red and white 
crosses which appear in the Connection column. The cross 
indicates a connection to or from the source or destination. 

If the list of sources is shorter than the list of destinations, then 
when you reach the last source in the list, the step mode 
automatically scrolls back up to the first source in the list.  

The step function can be used with an offset between the 
starting source and destination. 

At any time you can remove a series of routes by selecting the 
first destination and selecting DISCONNECT. If Step mode is 
active, then the list will step down to the next entry allowing you 
to disconnect a range of destinations quickly and easily. 
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Reverse Interrogation of Signal Routing 

Reverse interrogation provides a quick way of viewing all the 
sources feeding a particular destination, or all destinations 
routed from a particular source.  

To view all the destinations fed from a source: 

1. Select the source you wish to interrogate – e.g. Tone1 – 
on the left hand side of the Signal List display: 

The selected source is highlighted in black. 

2. Then right-click and select Show Destinations of 
source: 

A list of all current destinations for the selected source appears 
in the Destinations list: 
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To find the source which feeds a destination, reverse the 
procedure: 

1. Select the destination you wish to interrogate on the 
right hand side of the Signal List display: 

The selected destination is highlighted in black. 

2. Then right-click and select Show Source of 
Destination.  

The source assigned to the selected destination appears in the 
Sources list. 

Find Folder 

If you are unsure which directory or sub directory this source (or 
destination) belongs to, then you can use Find folder as 
follows: 

1. Right-click on the source (or destination) and select 
Find folder. 

The Directory and Subdirectory update to reveal the correct 
folder for the selected source: 
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Linking Stereo Signals 

You can link any consecutive pair of source or destination 
signals as stereo. 

This does not affect how the signals are routed, but affects the 
behavior of the signal‟s IO DSP, see Page 97. 

1. Select the odd numbered source or destination. 

Your selection is highlighted in black. 

2. Right-click and select the stereo option. 

The Stereo column reflects the status of any stereo signals: 
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Editing Source and Destination User Labels 

Single Label Edit 

Every individual source and destination is displayed with a fixed 
channel name and a user programmable label. You can edit 
user labels as follows: 

1. Select the source or destination label you wish to edit 
using the trackball: 

Click once to select all the existing text (white) or twice (black 
cursor) to modify the existing name. 

2. Enter a new name from the keyboard.  

3. When you have finished, press the Enter button on the 
keyboard to confirm the new name. 

4. Or, if you make a mistake or want to exit the naming 
mode without making any changes, press the Esc 
button on the keyboard. 

Note that user labels are stored in snapshots so that you can 
easily recall new labels for a different part of a show. 

5. Remember to save your snapshot and/or production 
after editing user labels.  

While editing a label, you can right-click using the mouse and 
right select button, and then Copy and Paste text to another 
signal. 

See the next page for a quick way to edit consecutive signal 
labels. 
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Easy Edit Mode 

This mode edits user labels for consecutive signals: 

1. Enable the Easy edit mode at the bottom left of the 
Signal List display: 

2. Select the first source or destination label you wish to 
edit and enter a label in the usual manner. 

3. Press Enter to confirm. 

With Easy edit mode enabled, the system automatically steps 
down to the next signal in the list. The text label is copied, and if 
the text ends with a number, then the number increments: 

4. Keep pressing Enter to label all the signals in the list: 

5. Press Esc to exit the naming mode. 
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Note that you can also enable Easy edit mode temporarily by 
using the SHIFT button on the console keyboard. 

With the Easy edit mode option unchecked: 

1. Select the first signal label you wish to edit and enter a 
label in the usual manner. 

2. Press and hold SHIFT and then press Enter. 

Holding down SHIFT temporarily enables Easy edit mode, so 
the system automatically steps down to the next signal in the 
list. The text label is copied, and if the text ends with a number, 
then the number increments. 

3. Press Esc to exit the naming mode. 
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Not Available Signals 

If a warning flag is present within the unavailable column, then 
a signal which should be present in the system is currently 
unavailable. This can be useful for fault finding and 
reassurance. 

For example, in an outside broadcast vehicle, you may have a 
number of remote Stageboxes. During the setup for the 
broadcast, you can make routes from microphone sources 
which connect to these Stageboxes, even if the Stagebox is not 
yet connected.  

The warning flag indicates that the signal is currently 
unavailable. However, you can continue to label the signal and 
make routes to/from it as normal. When the Stagebox is 
connected to the system this column updates accordingly and 
the warning flag disappears. 

If you need further help diagnosing system connections, see 
Page 76 for details. 
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Isolated Signals 

The I column indicates if a signal is isolated from a snapshot 
recall. For example, you may wish to protect important signals 
from accidental reset.  

To isolate a signal: 

1. Select the source or destination you wish to isolate, and 
right-click: 

2. Select the Isolated option. 

The I column updates to show the isolated signal status: 

When a snapshot is loaded, any routes made from an isolated 
source or to an isolated destination are not loaded. 

Note that the Isolate function does not prevent routes from 
being stored when a snapshot is saved or updated; Isolate only 
applies when settings are loaded back from a snapshot. 
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Protected Signals 

If you wish to apply more comprehensive protection to a matrix 
destination, then it can be protected so that nothing can alter its 
connection. 

To protect a signal: 

1. Select the destination you wish to protect, and right-click 
using the trackball and right select button: 

2. Select the Protected option. 

Protected destinations are displayed with a padlock icon in the 
connection column. 

From hereon, nothing can alter the connection – not the Signal 
List or mx Routing displays, not snapshots, productions, 
mxGUI or remote MNOPL. This is ideal for critical signals, such 
as mains distribution. 

3. To change the route to a protected destination, you must 
first turn off the Protected option.  

Note that only destinations can be protected. 

The state of protected signals is not saved or loaded by 
productions, snapshots or automation. Therefore, any changes 
are permanent and will affect all users. 
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Networking I/O Resources 

Two or more mc2/Nova73 systems may be networked to 
distribute I/O resources. For example, to share the same 
microphone source between two systems: 

In the above example, mics are physically connected, via a 
DALLIS I/O unit, to each system. Signals are transferred 
between systems via „Netlinks‟, providing the ability to route any 
mic to console A and/or console B.  

Each „Netlink‟ is an audio connection which may be MADI, 
ATM, AES or Analogue audio, and signals are dynamically 
allocated as each operator makes routes from the Signal List 
display. 

Any number of sources may be distributed depending on the 
physical limitations of your network. Please consult your 
technical representative for further details on your installation‟s 
configuration. 

On any system within the network, you can view which sources 
are distributed from the S/I column on the Signal List display: 

 An S indicates that a source is connected locally, and is 
„Shared‟ (made available) to other systems within the 
network.  

 An I indicates that a source is „Imported‟. In other words, 
it is not connected locally to this system. 
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On the system which is distributing the signals – in our 
example, console A - you can select which sources are shared 
from the Signal List display: 

1. Select the source you wish to share (e.g. Mic1). 

Your selection is highlighted in black. 

2. Right-click and select the share option. 

The S/I column updates to show that the source is now shared. 

3. Select SHARE again to unshare the source. 

Note that you cannot unshare a source if it has been routed as 
an imported source within another system. For example, if 
console B has made a route using the Mic 1 signal, then 
console A cannot unshare the Mic 1 source until console B‟s 
route is removed. This protects one console from removing 
routes which are in use by another within the network. 

If you wish to share a number of sources, then you can use the 
STEP function to step through and SHARE a number of 
sources.  

Once the source has been shared from console A, then other 
consoles within the network may access this source (shown as 
imported) from the Signal List display. 

Note that console B will only be able to access the source if its 
I/O configuration has been programmed to do so – i.e. a 
location for the imported source must have been created within 
an I/O directory and subdirectory. Please consult your technical 
representative for further details. 

Once console B can „see‟ the imported source, then making a 
route or changing parameters is done in exactly the same way 
as if the source were local to the console. 

Note that all consoles within the network have access to the 
source parameters, and the last console to make a change 
wins. In our example, consoles A and B both have access to 
mic pre-amp control for mics 1 and 2. Similarly for a shared 
digital destination, both consoles may change parameters like 
SRC, etc. In addition, SDI card parameters may be adjusted for 
a remote system. For more details on signal parameters, see 
Page 81. 

This operation extends to snapshots. So if both console A and 
B are using the Mic 1 signal, parameter settings like mic gain, 
etc. can be reset from snapshots from either console. To control 
which console resets the mic parameters, use the I/O snapshot 
filter to prevent recall of I/O settings, see Page 135. 
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The mx Routing Display 

The mx Routing display provides a crosspoint overview of 
signal routing, ideal if you want to make a large number of 
routes very quickly. Any routing changes made by the mx 
Routing display are reflected in the Signal List and vice versa. 

The display can be used to view or change signal routing, 
adjust signal settings or create partial snapshots.  

A “partial snapshot” is designed to store selected routing 
crosspoints. For example, you could use a partial snapshot to 
route tone to all transmission feeds for a line check. 

In addition, the mx Routing display allows you to prepare a set 
of connections and then action them simultaneously. 
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Signal Routing from the mx Routing Display 

1. Select Page -> Matrix -> mx Routing to view this 
display: 

The display shows a grid with sources running down the left 
hand side, and destinations running across the bottom. The 
names of the source and destination directories are shown at 
the top of the display – in our example, all Sources and all 
Destinations. 

If a source or destination is connected, then it is highlighted in 
red. In addition, if the source and destination are both in view, 
you will see a red and white cross on the grid to show the 
crosspoint connection.  

2. Position the cursor to select a source and a destination. 

The selections are highlighted in green. 

3. Now left-click to make (or unmake) the connection. 

The route is made as indicated by a red and white cross. 

4. You can choose to display only connected signals by 
selecting the Hide Unconnected Signals checkbox. 

 

 



 
Signal Routing/Settings 
The mx Routing Display  

64/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Selecting Directories and Subdirectories 

Just as on the Signal List display, signals are divided into 
Directories and Subdirectories. You can choose to view all 
Sources and all Destinations as in our previous example. Or, 
you can select a particular directory as follows: 

1. Select a directory and subdirectory from the drop-down 
Sources (or Destinations) list: 

The organisation of signals into directories and subdirectories is 
defined by the AdminHD configuration of your system. In our 
example, we have selected DALLIS -> Card 4 AES3: 

You can use the on-screen next and previous directory buttons 
to quickly navigate through recent selections – in our example, 
selecting the back button takes the view back to all Sources: 

 

 

 

 



 
Signal Routing/Settings 
The mx Routing Display  

mxGUI User Guide for Nova73 V4.14/3 65/ 221 

Right-click Operations 

1. Right-click on a signal to reveal a number of additional 
operations: 

 Signal Parameters 

Select the Show Source Parameters (or Show Destination 
Parameters) option to access a pop-up window where you can 
adjust parameters for the selected signal. In our example, we 
can adjust the user label and other input parameters for an 
analogue source: 

These signal options are identical to those found on the Signal 
Settings display, so please refer to Page 81 for more details. 

 Show mxDSP Parameters 

For a source from an mxDSP card, select Show mxDSP 
Parameters. The options are identical to those found on the 
mxDSP Settings display, so please refer to Page 101 for more 
details. 
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 Show Destinations of Source (DoS) or Show 
Source of Destination (SoD)  

This option can be used to reverse interrogate the connections 
made from the selected source or to the selected destination. It 
works in the same way as on the Signal List display. 

1. Select the source you wish to interrogate. 

2. Then right-click and choose Show Destinations of 
Source. 

The destinations update to show only those routed from the 
selected source – in our example, the A and B inputs of INP 1: 

Note that the destination directory has updated to Dest. Of 
Source (DoS). This means that if you now select another 
source, the display will show its destinations. 

3. To cancel the Destinations of Source view, either click 
on the previous directory button or select a different 
Destinations directory. 

You can also double-click on a source, or a destination, to 
activate the Destinations of Source or Sources of Destination 
function. 
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 Find Folder 

If you are unsure which directory or sub directory a source (or 
destination) belongs to, then you can use Find folder to locate 
it. This feature works in the same way as on the Signal List 
display. 

1. Select the source (or destination). 

2. Then right-click and choose Find Folder: 

The Source (or Destination) directory updates to reveal the 
location of the source folder: 
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 Search Signal 

This option is only available from the mx Routing display (it is 
not available from the Signal List) and allows you to search for 
a signal. For example, you may suspect that a CD player is 
defined within the signals list but do not know its directory: 

1. Right-click and select Search Signal to open the Signal 
find pop-up window: 

2. Type in the name or user label of the source (or 
destination) you wish to locate – in our example, CD. 

3. Then select find signals. 

The system searches the system name and user label for all 
matching text strings – in our example two sources named CD 
Left and CD Right have been found. 

4. Now select one of the results and right-click: 

 Use Show Destinations of Source (DoS) to view all 
connections made from the source. 

 Or, Show Folder in Matrix to open the source directory. 
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 Protected Signals (Destinations only)  

This option can be used to protect a destination. It works in the 
same way as on the Signal List display. 

1. Select the destination you wish to protect, and right-
click: 

2. Select the Protected option. 

Protected destinations are displayed with a padlock icon: 

From hereon, nothing can alter the connection – not the Signal 
List or mx Routing displays, not snapshots, productions, 
mxGUI or remote MNOPL. This is ideal for critical signals, such 
as mains distribution. 

3. To change the route to a protected destination, you must 
first turn off the Protected option.  

Note that only destinations can be protected. 

The state of protected signals is not saved or loaded by 
productions, snapshots or automation. Therefore, any changes 
are permanent and will affect all users. 
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 Go to Downmix 

If the selected source or destination is an input or output to a 
downmix matrix, then this option automatically opens the 
Downmix display. This allows you to control the downmix 
parameters. See Page Error! Bookmark not defined. for 
details. 
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Preparing Signal Routing (the Take Button)  

In addition to making routes one by one, the mx Routing 
display allows you to prepare a set of connections and then 
action them simultaneously. 

1. BEFORE you make or unmake any connections, select 
the Prepare Routing checkbox on the left of the display. 

This puts the display into „prepare‟ mode. 

2. Now make (or unmake) the connections. 

At this stage, the connections have only been prepared and are 
not yet active; therefore they are displayed with a different icon: 

3. When you have completed the prepared routes, select 
the Take button at the top right of the display. 
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All prepared connections (and disconnections) are actioned, 
and the icons change state to reflect the routes made: 

4. You can now prepare another set of connections and 
action them from the Take button. 

5. When you are finished, remember to deselect the 
Prepare Routing checkbox to return the display to its 
normal mode of operation. 
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Partial Snapshots 

A “partial snapshot” is designed to store selected routing 
crosspoints. For example, you could use a partial snapshot to 
route tone to all transmission feeds for a line check without 
affecting other aspects of the mix.  

Note that a partial snapshot also stores and recalls signal 
parameters such as mic pre-amp gain and SRC on/off for the 
selected sources and destinations. 

Partial snapshots are prepared from the mx Routing display, 
and saved and loaded from the Snapshots display. 

1. Open the mx Routing display. 

2. Use circles beside each source and destination to select 
which will be stored within the partial snapshot: 

When a source or destination is selected, its circle turns blue. 

 If you select a destination, the partial snapshot stores the 
route made to the destination and the destination‟s I/O 
parameters. 

 If you select a source, the partial snapshot stores only the 
source I/O parameters. 

Therefore, to store crosspoints in a partial snapshot, always 
select the destinations. In our example, we want to store routes 
to the AES feeds and so have selected these destinations: 

The half blue circle beside DEST DIR indicates that some 
signals within the directory are selected. To select all sources or 
destinations within a directory, select this circle (full blue). 

Clear All clears all partial snapshot selections made throughout 
the entire routing matrix. Use this when you wish to clear down 
any active selections in preparation for a new partial snapshot. 
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3. Now go to the Snapshots display and select Save 
Partial at the bottom of the display. 

The system saves the routes made to the selected destinations 
in a new partial snapshot: 

Note that the type of snapshot is marked in the Type column to 
distinguish partial snapshots from full snapshots.  

4. Return to the mx Routing display and make the new 
routes to your selected destinations – in our example, 
Tone to the transmission feeds: 
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5. And save another partial snapshot from the Snapshots 
display: 

6. At any time you can now load the partial snapshots to 
recall routes made only to the transmission feed 
destinations. 

Note that it is the blue circle selections when the partial 
snapshot is saved which defines which routes and I/O settings 
are stored. This allows you to save partial snapshots for 
different subsets of signals. 

Note that you can use Isolate to isolate a source or destination 
from the partial snapshot recall. So, if you do not wish to reset 
one of the stored destinations, then Isolate it from the Signal 
List display. 

Partial snapshots are treated in exactly the same way as full 
snapshots, so you can load, update, protect or delete them from 
the Snapshots display, see Chapter 7 for details. 

7. To update an existing partial snapshot, be sure to select 
Update Partial: 

8. Remember to save or update the production in order to 
save snapshots permanently. 
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The Signal Settings Display 

The Signal Settings display has two functions: to monitor the 
status of system hardware, and to set parameters for individual 
input and output signals. 

1. Select Page -> Signals -> Settings to view this display: 

The two “trees” on the left of the display show the location of a 
signal within the Signal List (top) and its physical location in 
the System (bottom). Whenever a signal is selected from the 
Signal List, the System tree follows, and vice versa.  

You can open or close branches of the Signal List or System 
tree by clicking on the arrows or double-clicking on a 
directory/component name. 

As you select signals, a graphical representation appears in the 
middle of the display – in our example, we can see the DALLIS 
where our mic signal is connected.  

If all is well with the system hardware, then the components are 
coloured grey. However, if there is a problem, the component 
will be highlighted in red, and you will see a red/white cross 
next to the component name in the system tree. 
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When you select an individual signal, a number of parameter 
tabs appear at the bottom of the display – in our example, 
General, Source, Mic/Line, Input DSP and Device: 

Note that the parameter tabs depend on the type of signal 
selected. 

2. Select a tab to access I/O parameters for the selected 
signal. 

When working with the Signal Settings display you can resize 
the different areas by clicking and dragging the grey separator 
bars - for example, during normal operation you might hide the 
System tree until it is needed. If information within an area is 
hidden, then left/right or up/down scroll bars will automatically 
appear. 
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Follow list selection 

You can link the Signal List and Signal Settings displays so 
that when you select a signal from the Signal List display, and 
switch to System Settings, the selected signal follows. For 
example: 

1. Go back to the Signal List display and select a source – 
in our example, the source named Mic 01: 

2. Make sure that the follow list selection option is 
checked at the bottom of the display. 

3. Then page back to the Signal Settings display: 

The Signals and System trees should have automatically 
opened to reveal your selected source. 
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Diagnosing System Errors 

When running mxGUI online, you can use the Signal Settings 
display to monitor your system hardware. 

In the unlikely event of a component failure, a hazard warning 
flag appears in the title bar of the screen. Note that this flag will 
appear at the top of any mxGUI display, so you don‟t need to be 
viewing the Signal Settings to monitor your hardware: 

1. Select the Signal Settings display: 

A red/white cross and highlighted card reveal the problem. 

2. If the fault is hidden within the System tree, follow the 
red warning flags and open each branch of the tree to 
find the problem – in our example, a DALLIS card: 

If you open the DALLIS card further, you will see grey/white 
crosses beside Signal In 1, Signal In 2, etc. These show that 
the AES signals are no longer available: 

3. Check and replace the card if necessary.  

Once all components are connected and working correctly, the 
red/white crosses disappear from the System Settings display 
and the hazard warning flag is cleared. 
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The System Tree 

The System tree can be opened as follows: 

1. Close and then reopen the System to see all the Cores 
contained within your system network – e.g. Core 1: 

2. Open Core 1 to see all the Modules fitted to the core, 
and its power supplies – PSU 1 and PSU 2: 

3. And open a Module to view its ports and then any 
DALLIS units connected to those ports: 
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Setting I/O Parameters 

Each time you select an individual signal within the Signal 
Settings display, you can adjust its I/O parameters from the 
bottom of the display. 

1. Open up the system tree until you find the signal you 
wish to adjust – in our example, Mic 01. 

A number of parameter tabs appear at the bottom of the display 
– in our example, General, Source, Mic/Line, Input DSP and 
Device. 

2. Select a tab to access the I/O parameters for the 
selected signal: 

Note that the parameters vary depending on the type of signal – 
Mic, Line, AES, SDI, etc. – and whether you have selected an 
input or output. You can find details for all parameters by 
referring to the datasheet for the card available from the Lawo 
website. Here we will cover the most common i/o cards.  
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General Parameters 

 Signal name 

This field displays the signal name as defined by the AdminHD 
configuration. Note that you cannot edit this name from mxGUI. 

 User label  

This field can be used to edit the user label for the selected 
signal.  

This is the same as the Source Label (input signals) or 
Destination Label (output signals) on the Signal List display: 

1. Click on the existing label to enter a new name. 

A cursor appears within the label field. 

2. Enter your new name. 

For more details on names and labels, see Page 54. 
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 Signal Stereo 

Check this option to link an odd/even pair of signals for stereo. 
The stereo linking affects the behavior of the IO DSP, see Page 
97 for details. 

Note that signals can also be stereo linked from the Signal List 
display, see Page 53. 

 Signal Isolate 

Check this option to isolate a signal from a snapshot recall. 

Note that signals can also be snapshot isolated from the Signal 
List display, see Page 58. 

 Inherited Label (Output Signals only) 

This field only appears when an output signal is selected: 

If the selected output is routed from a source, then this field 
displays the inherited user label and is for information purposes 
only. 
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Source Parameters (Input Signals Only)  

These parameters only appear when an input signal is selected. 

 Mix minus Self Monitoring 

This feature is not relevant for Nova73. 

 Mix minus Bus 

This feature is not relevant for Nova73. 
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Mic/Line Parameters (Mic/Line Signals Only)  

These parameters only appear when an input signal from a 
Mic/Line card is selected, and duplicate the parameters 
available from the Central Control section: 

 Line select 

Click on the drop-down menu to switch the input between mic 
or line. 

 Phantom power 

Check this option to enable phantom power. Phantom power 
can only be enable when the input is switched to Mic. 

 Low cut 

Click on the drop-down menu to select a cut-off frequency for 
the high pass (low cut) filter prior to analogue-to-digital 
conversion. You may select: off, 40Hz, 80Hz or 140Hz. 

 Gain 

Use this field to adjust the input gain of the signal.  

You can either click on the existing entry and type in a value, or 
click on the up/down arrows beside the field to increment or 
decrement the value in 1dB steps. 
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 Pad 

Check this option to enable the 20dB Pad prior to analogue-to-
digital conversion. 

 Stereo Gain and Balance 

If a signal is designated as a stereo source within the Signal 
List, then you may use these fields to adjust the gain and 
balance of the left and right signals. 

Either click on the existing entry and type in a value, or click on 
the up/down arrows beside the field to increment or decrement 
the value in 1dB steps. 

See Page 53 for more details on configuring a stereo source. 
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AES/EBU Inputs (AES/EBU Signals Only)  

For an AES/EBU input signal, you can turn sample rate 
conversion on or off. 

Note that not all AES/EBU cards support sample rate 
conversion so this option may not be available for all signals. 

Also note that to make a digital path suitable for Dolby E 
operation, you should disable any sample rate conversion and 
I/O DSP. 

 Sample Rate Converter On/Off (Sample Rate 
Conversion) 

As a default, this parameter is enabled (checked). 

Uncheck this option to disable the sample rate converter for the 
selected source.  
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AES/EBU Outputs (AES/EBU Signals Only)  

These parameters only appear when an output signal from an 
AES/EBU card is selected. 

For an AES/EBU output signal, you can adjust the sample rate 
and the wordlength. 

Note that both options affect the status of the sample rate 
converter. Therefore, to disable the SRC to make the output 
path suitable for Dolby E operation, set these options according 
to the table in Appendix A.  

 Sample Rate and Use System Sample Rate 

The default state for digital outputs is that they are referenced 
to the system clock – in other words, the Use System Sample 
Rate option is checked, and the Sample Rate field is set 
accordingly. 

Note that the SRC flag is for display purposes only and when 
unchecked (as above) shows the sample rate conversion is out 
of circuit. 
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On digital outputs with sample rate conversion (SRC), you may 
alter the clock selection of each output. For example, you may 
wish to send a 44.1kHz feed to a CDR. Note that, depending on 
your hardware specification, sample rate conversion may be 
unavailable on some digital outputs. 

1. To change the sample rate of the digital output, select 
the Sample Rate parameter and choose from the drop-
down menu options: 

 follow – sets the output sample rate to follow the input 
sample rate from which it is routed. 

 44.1 KHZ – 44.1kHz. 

 48 KHZ – 48kHz. 

On systems running at higher sample rates, you can also 
select: 

 88.2 KHZ – 88.2kHz. 

 96 KHZ – 96kHz. 

Selecting a different sample rate will automatically uncheck the 
Use System Sample Rate option and check the SRC status 
flag: 

2. To reset the digital output so that it is referenced to 
system clock, reselect Use System Sample Rate. 

For details on setting the system sample rate, see Page 191. 
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  Word Length 

The word length for each digital output defaults to 24-bit unless 
you select otherwise. 

Note that dither is automatically applied to signals reduced to 
20- or 16-bits. In addition, your wordlength selection may 
change the status of output sample rate conversion; see the 
table in Appendix A for details. 

1. To change the wordlength for a digital output, select the 
Wordlength parameter and choose from the available 
drop-down menu options: 

 24 bit 

 20 bit 

 16 bit  

Note that when 16 or 20-bit are selected, dither is automatically 
applied. 
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SDI Parameters (DALLIS 3G/HD/SD SDI Card)  

The DALLIS 3G/HD/SD SDI card (946/17) is a multi-rate SDI 
card with BNC input, thru and two outputs. It contains an audio 
embedder and de-embedder for up to 16 audio channels, and a 
VANC embedder and de-embedder for two independent Dolby 
E Metadata streams. There is onboard video and audio delay, 
and an integrated sample rate converter. It occupies two 
DALLIS card slots and may be configured to run in a number of 
different modes using Admin HD.  

For more details and block diagrams, please refer to the 
relevant data sheet available at http://www.lawo.de 

Note that SDI signals have parameters for both the signal and 
the card. The SDI parameters are adjusted by selecting the 
card: 

1. Select the 946/17 card from the System tree. 

2. Then select one of the four tabs: 

Note that SDI card parameters may be adjusted whether the 
card is local to the system, or fitted to a remote network partner: 

 

 

 

 

http://www.lawo.de/


 
Signal Routing/Settings 
The Signal Settings Display  

92/ 221 V4.14/3 mxGUI  User Guide for Nova73 

 3GSDI 

 SRC – check this option to enable sample rate 
conversion. Note that SRC is applied to all channels on 
the card. Normally, SRC should be enabled. If SRC is 
off (unchecked), then the system must be clocked to the 
same reference as the sending device. 

 Enable video delay & Video delay (frames) – this 
option applies a delay to the SDI data from the de-
embedder to embedder. Video and audio containted in 
the stream are delayed by the same amount. Set the 
amount of Video delay in steps of 1 video frame. 

 Video generator mode, format & test pattern – the 
SDI card is equipped with a free-running video test 
pattern generator. Set the mode to either: 

o Auto – if the input is locked to an incoming video 
signal, then the output will automatically track the 
format of the input. If the input fails, then the video 
test pattern generator transmits the last received 
video format. When the SDI module is part of a SDI 
chain, this option is recommended. 

o Force On – in this mode it is assumed that the card 
is used as a video master and that no SDI input 
signal is applied. The test pattern generator is forced 
on all the time. Use the Video generator format and 
Generator test pattern options to define the video 
signal. In this mode the embedder sample rate is 
derived from the generator, and the SDI receiver is 
switched off. Note that the de-embedder cannot be 
used. 
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 Embedder 

 Clean – check this option to set the embedder mode to 
“Clean”. In this mode the incoming audio stream is 
deleted and a new data structure generated according to 
your embedder settings. Note that if you select this 
mode any existing audio data will be lost. 

 Embedder Group Enable – audio is embedded in 
groups of four channels into SDI. There is a total of four 
groups per SDI, resulting in 16 audio channels. For each 
group, this checkbox determines whether the incoming 
SDI stream is replaced: 

o Enable the checkbox to replace the audio group 
content. 

o Disable the checkbox to leave the audio group 
untouched. 

If there is no audio at the SDI input, then a new audio group will 
be generated.  

Note that in Admin HD modes 16/0 and 8/0, all embedder group 
enables are turned off as the whole embedder section is 
bypassed. 

 Embedder source 1 to 16 – use these options to define 
the source for each embedder. 
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 De-Embedder 

 DALLIS signal in source 1 to 16 – use these options to 
define the source for each de-embedder. 

 Metadata 

The SDI module offers 2 metadata ports according to SMPTE 
RDD-2008. This allows embedding, de-embedding and 
transport of two independent Dolby metadata streams 
alongside with the video. The streams can be accessed via two 
D-Sub connectors at the front panel. 

 Metadata de-emb. & emb. to port 1, 2 - use these 
options to define the streams for the Metadata ports. 

 Metadata embedder mode & line – set the mode to 
Auto to track the input, or select Pre-selected line and 
define a Metdata embedder line. 
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SDI Parameters (DALLIS non 3G SDI Cards)  

The DALLIS HD or SD SDI cards (946/13, 09, 05, 01) provide 
the ability to route a maximum of 8 channels to/from the SDI 
stream. Sample rate conversion may be applied to the whole 
card (all 8 channels), and delay may be applied to either the 
embedded or de-embedded signals. 

You can find specific details on each card by referring to the 
datasheet available from the Lawo website. 

SDI parameters can be adjusted for the card and for individual 
signals as follows: 

 SDI Card 

1. Select an SDI card from the System tree, and click on 
SDI to adjust the following card parameters: 

 SRC – check this option to enable sample rate 
conversion. Note that SRC is applied to all 8 channels 
on the card. Normally, SRC should be enabled. If SRC 
is off (unchecked), then the system must be clocked to 
the same reference as the sending device. 

 Delay – select whether delay is enabled for the 
Embedded (SDI output) or De-embedded (SDI input) 
signals; delay cannot be applied to both. 

 Generator signal, mode and format – defines the 
output generator signal for the SDI stream. 

 Embedder mode – select from: 

o On – audio channels will be replaced within the 
existing SDI data structure according to your SDI 
output group selections. 

o Off – no audio replacement; the SDI stream remains 
unaltered. 

o Clean – deletes the incoming audio stream and 
generates a new data structure according to your 
embedder settings. Note that if you select this mode 
any existing audio data will be lost.  
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 SDI Inputs 

Select an SDI input signal from the System tree, and click on 
SDI to adjust the following signal parameters: 

 Group select – this field defines which pair of SDI 
channels will map to the selected SDI card input. In our 
example, Group 2 Channels 3&4 from the SDI stream 
will be de-embedded to SDI Signal In 1 and 2.  

 Delay time and Delay – check the Delay option to 
enable delay for the stereo input, and set the delay time 
in ms. Delay time can be adjusted from 0 to 240ms. 

Note that the delay will only be applied to SDI inputs if the SDI 
card Delay parameter is set to De-embedder. 

 SDI Outputs 

Select an SDI output signal from the System tree, and click on 
SDI to adjust the following parameters: 

 Group select – this field defines which pair of SDI 
channels will map to the selected SDI card output. In our 
example, Group 1 Channels 1&2 from the SDI stream 
will be embedded to SDI Signal Out 1 and 2.  

Note that the assignment will only be active if the SDI card 
Embedder mode is set to On or Clean. 

 Delay time and Delay – check the Delay option to 
enable delay for the stereo output, and set the delay 
time in ms. 

Note that the delay will only be applied to SDI outputs if the SDI 
card Delay parameter is set to Embedder. 

 Wordlength – choose from the available drop-down 
menu options. 

Note that when 16 or 20-bit are selected, dither is automatically 
applied. 
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I/O DSP 

For any type of input or output signal, a DSP module on the I/O 
card allows adjustment of the signal gain (volume) and phase. 

Note that to make a digital path suitable for Dolby E operation, 
you should turn off the I/O DSP for both the input and output, 
and disable any sample rate conversion. 

 I/O DSP On/Off 

As a default, I/O DSP is turned on (checked). I/O DSP must be 
turned on for Volume and Phase to be active. 

Disable this parameter to switch the I/O DSP module out of 
circuit – for example, for Dolby E operation. 
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 Volume (Level Control) 

The Volume field allows you to set an offset level within the 
router for the selected source or destination. 

For example, if you are providing feeds to broadcast stations 
requiring different line-up levels, you may apply this level 
compensation within the router rather than at the main sum or 
group output.  

1. Click to enter a value from the keyboard or click on the 
up/down arrows to increment or decrement the level in 
0.5dB steps. 

Levels may be adjusted from -128dB to +15dB. 

 Phase  

1. Tick the Phase box to reverse the phase of the signal. 

 

Note that Volume and Phase are only applied if I/O DSP is 
switched on.   
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Device Parameters 

 HLSD 

This field describes the HLSD address which is used to identify 
the signal within the system. This is a unique address which 
cannot be modified by the user, but may be useful for 
diagnosing errors within your system or AdminHD configuration.  

Please consult the “Nova73 Technical Manual” for further 
details. 
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Tone Generator Control (Internal Tone only) 

Depending on the hardware specification of your system, the 
system may have access to one or more internal tone 
generators. Each tone generator is located on the DALLIS DSP 
card 947/42, and in a system with multiple DALLIS cards, 
settings may be adjusted independently for each generator. 

When a tone signal is selected, the Signal Generator tab 
appears in the i/o parameter area: 

 Frequency 

Click on the up/down arrows beside the frequency to change 
the sine wave generator signal. Each time you click you will 
step through the following options:  

20, 49.9, 100, 200, 400, 440, 1000, 2000, 2998, 3999, 4987, 
6997 Hz and 10.0, 15.0, 20.0 kHz 

 Level 

This field adjusts the level of the generator signal. 

You can either click on the existing entry and type in a value, or 
click on the up/down arrows beside the field to increment or 
decrement the value in 1dB steps. 

The level may be adjusted from 0dB to -128 dB. 

 Type 

Select the type of generator signal from: 

 sinewave – sine wave. 

 whtnoise – white noise. 

 pnknoise – pink noise. 
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The mxDSP Settings Display 

This display can be used to control the DSP settings of any 
mxDSP cards fitted to your system. 

A mxDSP card provides a pool of DSP resource which can be 
applied to signal paths within the routing matrix. For example, to 
apply fixed DSP settings to line arrays.  

Each mxDSP card occupies one slot within the HD Core and 
provides DSP “chains” which can be viewed and controlled from 
the mxDSP Settings display.  

Several configuration options are supported, providing up to 
192 DSP chains plus a 64 x 64 mixing matrix per card. The 
DSP chains are configured from various elements including 
level, mute, delay, EQ, etc. The number of DSP chains, and 
their signal flow, is determined by the AdminHD configuration: 

 

Note that a 983/03-007 mxDSP must be configured using 
AdminHD, and new software loaded to the card, before the 
following features become available. Please refer to the Nova73 
Technical Manual. 

The Config-ID can be changed, using AdminHD, while running 
online. 
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Controlling DSP Parameters 

1. Select Page -> Matrix-> mxDSP Settings to view this 
display: 

On the left of the display you will see: 

 DSP Chain Type – this lists all the DSP chain types 
offered by the card. The types are pre-defined by the 
card configuration (defined within AdminHD). Types in 
grey are not supported by the current configuration. 

 DSP Chain – this lists the individual DSP chains. Here 
you can name and label each chain and view its source 
and mono/stereo configuration. 

2. Select a DSP Chain from the list to view its signal flow. 
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3. Then click on one of the signal flow blocks – e.g. Par-
EQ – to display the current parameters: 

4. Adjust parameters using the mouse buttons in the usual 
manner. 

See Page 25 for tips on using the GUI to adjust parameters 
values. 

You can adjust parameter values for any DSP block within any 
DSP chain. 

Note that you cannot change the Stereo configuration of a DSP 
Chain from the mxDSP Settings display. This operation must 
be performed from the Signal List display (see next page). 

 

 



 
Signal Routing/Settings 
The mxDSP Settings Display  

104/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Controlling the 64x64 Summing Matrix 

Depending on the Admin HD configuration, each mxDSP card 
may support a 64 x 64 summing matrix.  

You can control routing to and from the matrix crosspoints using 
either the Signal List or mx Routing displays, see Page 111. 

For each of the 64 summing matrix inputs and outputs, you may 
adjust the following settings from the mxDSP Settings display: 

 Input level, phase and mute. 

 Output level, phase and mute. 

 Crosspoint level and on/off status. 

Note that the summing matrix defaults to all levels at 0dB, all 
phase, mutes and crosspoints off. 

1. Select Page -> Matrix-> mxDSP Settings. 

2. Scroll through the entries in the DSP Chain Type list, on 
the left, and select Sum Matrix. 

The display shows settings for the selected summing matrix – in 
our example, Matrix 1: 

On the left of the display, the Sum Matrices area lists all 
matrices configured within the system. For example, if you have 
several mxDSP cards, configured with a summing matrix, then 
you will see Matrix 1, Matrix 2, etc. 

The Views list can be used to filter the number of signals in 
view, see Page 109. 
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Controlling the Matrix Settings 

The main area of the display shows the crosspoint on/off status 
and levels for the signals in view: 

In our example, inputs 1 to 64 run down the left hand side, and 
outputs 1 to 64 across the bottom.  

1. Use the scroll bars to access all 64 signals. 

2. Select Inherit Label (bottom left) to view the source and 
destination labels, from the Signal List, rather than the 
default labels shown above. 

In the main grid, each box shows the matrix crosspoint level in 
dB. If a crosspoint is active, then its box has a heavy green 
outline. 

The yellow outlines provide a reference to show which input, 
output and crosspoint will be affected by the DSP buttons on 
the left of the display (Input Phase, Input Mute, etc.) 

The circles beside each input and output signal are used to 
create views, see Page 109. 
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 To Adjust a Matrix Crosspoint 

1. Click on the crosspoint you wish to adjust. 

The yellow outline updates. 

2. Click on the up and down arrows or type in a new level. 

The crosspoint level may be adjusted from -128dB to +15dB. 

3. Select XPoint On to turn the crosspoint on or off. 

When active, the crosspoint box has a heavy green outline. 

4. Select XPoint Phase to reverse the phase of the 
crosspoint. 

When active, the button turns blue. 
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 To Adjust a Matrix Input 

1. Click on any crosspoint within the input row you wish to 
adjust – for example, input 3. 

2. Use the level box below the Inputs list to adjust the 
input level. 

The input level may be adjusted from -128dB to +15dB. 

3. Select Input Phase to reverse the phase of the 
summing matrix input. 

4. Select Input Mute to mute the input. 

The input level box turns red if the input is muted. 
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 To Adjust a Matrix Output 

1. Click on any crosspoint within the output column you 
wish to adjust – for example, output 5. 

2. Use the level box at the bottom of the column to adjust 
the output level. 

Output level may be adjusted from -128dB to +15dB. 

3. Select Output Phase to reverse the phase of the 
summing matrix output. 

4. Select Output Mute to mute the output. 

The output level box turns red if the output is muted. 
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Views 

To reduce the number of signals in view to a more manageable 
number you can use Views. 

1. Select the circles beside each input and output signal 
you wish to include within the matrix View: 

When a signal is selected, its circle turns blue: 

2. Now select Save at the bottom of the Views area. 

The Views list updates accordingly: 

3. To apply the View, select the checkbox beside Filter. 

When the Filter checkbox is active, the crosspoint grid only 
shows signals stored within the selected View: 

4. To return to all signals, deselect the Filter checkbox. 
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You can store as many Views as you wish, and perform the 
following operations by right-clicking on a View: 

 Update – select a different set of signals and click on 
Update to update an existing View. 

 Delete – deletes the selected View. 

 Rename – renames the selected View. 

 Reload – reloads the selected View. 

Note that the half blue circle beside Inputs and Outputs 
indicates that some but not all signals are selected: 

 To select all signals, select this circle to make it full blue.  

 To deselect all signals, select it again to make it full 
white. 
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Routing Signals to/from the mxDSP Card 

Each DSP Chain can be routed from any source and to one or 
more destinations using either the Signal List or mx Routing 
displays. See Pages 46 and 62 respectively. 

The exact location of the mxDSP signals depends on the 
configuration of your system‟s Signal List. In our example, 
mxDSP Signals appear within the main Directories.  

To route a source to a DSP chain: 

1. Select your source in the usual manner. 

2. Then select the destination: 

 Select mxDSP Signals from the Directory list. 

 Select the DSP Chain type from the Subdirectories – 
e.g. EQ Lim 1. 

 Select the DSP Chain from the Destinations list – e.g. 
EQ_L 1: 

 

3. Press CONNECT to make the route. 

4. Return to the mxDSP Settings display, you will see the 
Label of the assigned source beside the DSP Chain. 

 

 

 

 



 
Signal Routing/Settings 
The mxDSP Settings Display  

112/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Stereo Configuration 

An odd/even pair of DSP Chains can be configured for stereo 
operation. 

Note that surround configuration is not supported. 

This operation is performed from the Signal List display: 

1. Select the DSP chain you wish to make stereo and right-
click:   

2. Select the Stereo option. 

Green/red circles appear beside the DSP chains to indicate that 
they are now linked for stereo. 

3. Return to the mxDSP Settings display and you will see 
the stereo status indicated beside the DSP Chain and 
within the main Settings area: 
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Saving and Loading mxDSP Settings 

The settings for each mxDSP card are stored within snapshots 
and productions, so remember to update a production to save 
any changes. 

You can isolate all mxDSP signals so that they will not be 
affected by a snapshot load from the System Settings or 
Snapshots display, see Page 194 or 135.  
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The Downmix Display 

The Downmix display provides on-screen control of any 
downmix matrices supported by your system. For example, if 
you have a 5.1 surround to stereo downmix, then you may 
adjust how much level from the front LR, Centre, LFE and rear 
LR channels feed the stereo output. 

Note that to support downmix matrices, the required DSP 
resources must be fitted to your system‟s hardware and 
configured using AdminHD. Please refer to the mc266 Technical 
Manual for details. 

Controlling Downmix Parameters 

1. Select Page -> Matrix-> Downmix to view this display: 

 

In the top half of the display you will see a list of all available 
downmixes for your system. In our example, we have one 
downmix named 5.1 Mains. 

The downmix matrices, and their names, are defined by the 
console configuration, which can be modified using AdminHD. 
Please see the Nova73 Technical Manual for details. 

2. Enter a name in the Label field to apply a user name to 
the downmix.  

User labels are inherited into the Signal List and other routing 
displays.   
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3. Select a downmix from the list to view its parameters.  

Our example shows an 8 x 8 matrix which is configured to 
produce 4 stereo outputs (Downmix 1 to 4)  from a 5.1 input:  

4. You can adjust the following parameters for Downmix 1 
to 4: 

 Front level – from inputs 1 (Left) and 2 (Right). 

 Center level – from input 3 (Centre), unless Alt Center 
is active, see below. 

 LFE level – from input 4 (LFE). 

 Surround level – from inputs 5 (Surround Left) and 6 
(Surround Right). 

 Alt Center – use this option to replace the Center input 
with an alternate centre channel: 

o Off = no alternate centre is used. Input 3 feeds 
the Centre channel. 

o 1 = input 7 replaces input 3. 

o 2 – input 8 replaces input 3. 

You can use this option to generate a clean feed or alternate 
language downmix. For example, Downmix 1 might be your 
main programme, Downmix 2 the clean feed, and Downmix 3 
an alternate language version. 

 Output level – adjusts the output level for the stereo 
downmix. 
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5. Select Reset levels to reset the downmix to its default 
parameters: 

You will be presented with a confirmation pop-up: 

6. Select Yes to confirm. 

All parameters are reset to the default values stored in the 
console‟s configuration. 

Saving and Loading Downmix Settings 

The settings for each Downmix matrix are stored within 
snapshots and productions, so remember to update a 
production to save any changes. 

By default each matrix is isolated so that it will not be affected 
by a snapshot load. You can adjust this by selecting the Isolate 
box beside the matrix name in the Downmix display: 
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Chapter 7: Productions and 
Snapshots 

Introduction 

This chapter explains the operation of the Productions List 
and Snapshots displays. 

Productions form the top level for user data storage and store 
all the settings required for a production or type of job. 
Productions store low level settings such as SRC settings and 
System Settings display options, in addition to snapshots. 

Within each production, folders may be created to store multiple 
snapshots. Snapshots provide the ability to recall different 
setups during a show. 

What’s Stored in a Production?  

Each production holds multiple folders to store snapshots and 
sequences. (Automation is not relevant to Nova73).  

In addition, the production snapshot stores everything included 
in a snapshot plus the following low level user settings: 

 Input and Output sample rate converter settings 

 System Settings display options. 
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This means that you can store the current settings of the 
system simply by updating or creating a new production. You 
only need to create folders and snapshots if you wish to store 
and recall different setups within the same production. 

As productions store and recall low level settings which may 
cause a brief interruption to audio, they should not be loaded 
during a live show. Instead, use snapshots to recall settings 
while live on-air. 

What’s Stored in a Snapshot?  

The system offers two types of snapshot: 

Full Snapshots 

These are one-shot memories which may be used to recall 
settings during a live show. Every full snapshot stores all of the 
following settings:  

 CONN: signal routing connections for all sources and 
destinations using the Signal List display.  

 I/O: remote mic preamp and router I/O settings such as 
router level and word length. 

 LABEL: User Labels; the source and destination labels 
as made from the Signal List display. 

 MXDSP: all settings for the optional mxDSP cards. 

Partial Snapshots 

A “partial snapshot” stores selected routing crosspoints only. 
For example, you could use a partial snapshot to route tone to 
all transmission feeds for a line check without affecting other 
aspects of the mix.  

In this chapter we will deal with full snapshots. For more details 
on partial snapshots, see Page 73. 

Using Productions and Snapshots 

You should create a production for each client or type of work. 
For example, a production named „Olympic Games‟ may store 
the low level settings (reference levels, and SRC settings) for a 
series of broadcasts. Within this production, you may then 
create a number of folders to store and recall snapshots to 
bring back different signal routing for each show transmission. 

Remember to save settings regularly, either by saving a new 
production or updating the current one. Even if you have saved 
several snapshots, they are not stored until you update the 
production. 
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The Productions Display 

Productions are managed from the Production display. 

1. Select Page -> Production -> Production List to view 
this display: 

The display is divided into two halves:  

 Productions – lists all the productions stored on the 
Control System. This is where you can load, save, 
update rename, protect or delete a production.  

 Backups – lists any backup productions stored in 
temporary memory. Backup productions provide a level 
of undo in case you update or delete your production 
accidentally, see Page 127 for details. 

Note that the active production is shown in the title bar of the 
display – in our example, Olympic Games. You will always see 
the active production name across all displays. 

To the right of each production name you will see the date and 
time when the production was last saved or updated, and the 
size of the production file. You may also see a padlock icon 
indicating that the production is protected. 

 

 

 

 



 
Productions and Snapshots 
The Productions Display  

120/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Loading a Production 

You can load stored settings at any time by loading a 
production.  

Note that when you load a production you will lose the current 
settings of the system, so make sure that you have saved these 
settings if you wish to retrieve them at a later date.  

If you do make a mistake, don‟t panic! Every time a production 
is loaded, a backup of the current settings is created in the 
Backups list. See Page 127 for more details. 

1. Select the production you wish to load from 
Productions list (e.g. Football). 

The selected production is highlighted in black: 

2. Right-click and select LOAD to complete the operation. 

The system status will update, and the title bar shows that 
Football is now the active production: 

For additional confirmation, watch the status bar and you will 
see a loading… message indicating that production data is 
being loaded. 
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Saving a New Production 

You can save the current settings of the Nova73 system, 
including any snapshot folders, into a new production using the 
SAVE function. 

If you want to clear out any existing snapshot folders in the 
memory, then create a new production using the NEW function, 
see Page 124.  

To save a new production: 

1. Select the SAVE button to save the current settings into 
a new production: 

A new entry appears in the Productions list with a default 
name (e.g. production 0012).  

This entry is time and date stamped. The new production 
automatically becomes the active production as indicated in the 
title bar. 

For additional confirmation, watch the status bar and you will 
see a saving… message indicating that production data is 
being saved. 

 

 



 
Productions and Snapshots 
The Productions Display  

122/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Renaming a Production 

To rename the production: 

1. Click on the production name from the Productions list: 

Click once to select all the existing text (white) or twice (black 
cursor) to modify the existing name. 

2. Type in a new name.  

3. Press Enter on the keyboard to confirm the new name 
(e.g. Formula One): 

4. Or, if you make a mistake or want to exit the naming 
mode without making any changes, press the Esc 
button on the keyboard. 
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Updating a Production 

Having saved your settings in a new production, and renamed 
it, you should continue to save your settings regularly as you 
work by updating the active production.  

Note that updating overwrites the settings on the Control 
System. Therefore, make sure that you have selected the 
correct production to update. To avoid accidental updates to 
important productions, always protect them using the Protect 
function, see Page 123. 

If you do make a mistake, don‟t panic! Every time a production 
is updated, a backup of the current system settings is created in 
the Backups list. See Page 127 for more details. 

1. Select the production you wish to update from the 
Productions list.  

The selected production is highlighted in black (e.g. Formula 
One): 

Note that you can choose to update any production, not just the 
active one, so take care NOT to overwrite someone else‟s 
settings! 

2. Now right-click and choose Update from the drop-down 
menu options. 

3. Select OK to confirm the Update. 

The selected production is overwritten with the current settings 
as indicated by the new date and time stamp. 

For additional confirmation, watch the status bar and you will 
see a red saving… message indicating that the production data 
is being saved. 

Remember that a protected production cannot be updated. 
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New Production 

The NEW function creates a new production with an empty set 
of snapshot folders. Use this before saving a production when 
you wish to clear out any existing snapshots from the current 
memory.  

To create a new production: 

1. Select the NEW button. 

A new empty production is created – this is indicated by the 
empty active production name in the title bar at the top of the 
display: 

If you now change displays to view Snapshots you will find that 
all folders have been emptied from the memory.  

2. To save the current settings into the new empty 
production and give it a name, right-click and select 
UPDATE. 

All current settings are saved into the production which is given 
a default name (e.g. production 0011): 

The production is time and date stamped and may be renamed 
or protected in the usual manner. 
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Deleting a Production 

Deleting a production removes the production and all of its 
contents – snapshots - from the Control System.  

To prevent accidental deletion, protected productions may not 
be deleted. 

1. Select the production you wish to delete from the 
Productions list (e.g. Football). 

The selected production is highlighted in black: 

2. Right-click and choose Delete from the drop-down menu 
options. 

3. Select OK to confirm the Delete. 

Note that a protected production cannot be deleted. 

 

 



 
Productions and Snapshots 
The Productions Display  

126/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Protecting a Production 

A protected production cannot be updated or deleted. Always 
protect important productions as this will prevent accidental 
changes from using UPDATE or DELETE. 

1. Select the production you wish to protect from the 
Productions list (e.g. News). 

The selected production is highlighted in black. 

2. Right-click and select PROTECT: 

A padlock icon appears to show that the production is now 
protected.  

Importing and Exporting Productions 

A complete production, or elements of a production (such as a 
folder or snapshot) can be transferred between the mxGUI 
computer and an online Nova73 system using the File Transfer 
display. See Page 34 for details. 
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Backup Productions 

When a production is loaded, updated, deleted or cleared 
(using NEW production), a temporary backup of the current 
settings is created in the backup productions memory. Five 
backup productions are stored providing five levels of undo if 
you perform an operation accidentally without first saving your 
settings. 

For example, whilst setting up for Racing, the operator forgets 
to update the production. He/she decides to load a different 
production to check the settings for Olympic Games. In the 
background, the system automatically creates a backup 
production of Racing: 

Note that the name of the backup production is taken from the 
active production, in our example Racing. However, the backup 
is not a copy of the active production but a backup of the 
settings before the load operation was performed. This means 
that the settings stored within the backup production are the 
settings which the operator forgot to save before changing. You 
can see this by the different time and date stamp date for the 
Backup called Racing. 

The operator then loads back the production for Racing and 
realises their mistake.  
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To recover the unsaved settings: 

1. Select the entry named Racing from the Backups list. 

The backup production is highlighted in black. 

 

2. Right-click and select LOAD to load the backup 
production. 

The backup production settings are loaded. 

 



 
Productions and Snapshots 

The Productions Display  

mxGUI User Guide for Nova73 V4.14/3 129/ 221 

3. To save these settings permanently, you must now use 
SAVE to save the settings in a new production with a 
new name, or UPDATE to update the original Racing 
production. 

In our example, we have saved a new production and named it 
Racing New: 

Warning 

If you do not save or update the settings to a permanent 
production, then they may be lost forever. The backup 
productions memory is a first-in first-out memory holding a 
maximum of 5 backup productions. 

Note a backup production is created each time a production is 
loaded, updated, deleted or when NEW production is used to 
clear any existing folders.  

For example, it may be used if you update a production with the 
wrong settings, or if you press NEW instead of SAVE and 
accidentally clear some snapshot folders by accident. To 
recover your settings, load the backup production with the same 
name as the active production which you accidentally updated 
or cleared. This will contain all the settings before you pressed 
NEW or UPDATE. 
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Folders 

Folders are used to organise snapshots within a production. 
Each production may contain any number of folders, and within 
each folder you may store multiple snapshots. 

For example, you may use folders to organise the snapshots 
required for different live broadcast events within a single 
production. 

Note that the BACKUP Folder is a special folder used to store 
backup snapshots. This Folder cannot be deleted. See Page 
141 for details. 

Creating a New Folder 

You can create a new folder from the Snapshots display.  

1. Select Page -> Snapshots -> Snapshot Lists to view 
this display: 

2. Select NEW to create a new folder. 

A new folder appears in the Folders column with a default 
name (e.g. Folder 0000): 
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Renaming a Folder 

To rename the folder:  

1. Select the folder name: 

Click once to select all the existing text (white) or twice (black 
cursor) to modify the existing name. 

2. Enter a new name from the keyboard.  

3. When you have finished, press the Enter button on the 
keyboard to confirm the new name. 

4. Or, if you make a mistake or want to exit the naming 
mode without making any changes, press the Esc 
button on the keyboard. 

Deleting a Folder 

To prevent accidental deletion of snapshots only empty folders 
may be deleted. Therefore, first delete any snapshots contained 
within the folder before attempting this operation. 

1. Select the folder you wish to delete from the Folders 
list: 

2. Right-click and select DELETE. 

The folder is deleted. Note that only empty folders may be 
deleted. 

Importing and Exporting Folders 

A complete folder can be transferred between the mxGUI 
computer and an online Nova73 system using the File Transfer 
display. See Page 34 for details. 
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Snapshots 

Snapshots provide the ability to store different setups within a 
singe production. 

Note that the system offers two types of snapshot: 

 Full snapshots – one-shot memories which store all 
matrix settings (see Page 118). 

 Partial snapshots – store selected routing crosspoints. 

In this section we will be dealing with full snapshots. However, 
the same principles of load, save, delete, etc. may be applied to 
partial snapshots. For more details on partial snapshots, see 
Page 73. 

Snapshots are organised within Folders within a production. If 
you save or update snapshots, remember to also update your 
production to save the new folders and snapshots to the Control 
System.  
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The Snapshots Display 

Snapshots are managed from the Snapshots display. 

1. Select Page -> Snapshots -> Snapshot Lists to view 
this display. 

2. Select a folder from the Folders list (e.g. Music). 

The Snapshots list displays all snapshots contained with the 
selected folder: 

When snapshots are first saved, they are given a default name 
which gives the snapshot a unique number. You may then 
rename the snapshots at any time. 

The snapshot type indicates whether it is a full or partial 
snapshot, see Page 118. 

Every snapshot also has a date and time stamp as shown in the 
Date Time column. The padlock icon column is used to identify 
any snapshots which have been write-protected. This prevents 
snapshots from being updated or deleted accidentally during 
operation. At the bottom of the display, the Snapshot Memo 
box may be used to make notes for a particular snapshot.  

Remember that you will always see the name of the last 
snapshot saved or loaded in the title bar across all displays – in 
our example, Act 1 Scene 2. 
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Loading a Snapshot 

1. Select a folder from the Folders list. 

2. Then select a snapshot from the Snapshots list. 

The selected snapshot is highlighted in black. 

3. Right-click and select LOAD to complete the operation. 

The system instantly updates to the loaded snapshot settings; 
the name of the loaded snapshot appears in the title bar of the 
display: 

Isolating Sources and Destinations from a 
Snapshot Load 

Note that you may isolate particular sources and destinations 
from a snapshot recall by selecting the Isolate function from the 
Signal List display. For example, you may wish to protect 
important signals. See Page 58 for details. 
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Global Snapshot ISO 

In addition, the Global Snapshot buttons on the Snapshots 
display allow you to isolate different console elements from a 
snapshot recall: 

Select these buttons before you load a snapshot to isolate the 
following elements: 

 DESK: not applicable to Nova73. 

 DSP: not applicable to Nova73. 

 CONN: signal routing connections for all sources and 
destinations using the Signal List display.  

 I/O: remote mic preamp and router I/O settings such as 
router level and word length. 

 LABEL: User Labels; the source and destination labels 
as made from the Signal List display. 

 BAY: not applicable to Nova73. 

 MXDSP: all settings for all mxDSP card signals. 

Select the button or buttons for the elements you do NOT want 
to recall and then load the snapshot. Note that you may select 
all buttons except one to load only a single element, for 
example signal routing. 
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Saving a Snapshot 

1. Select the folder you wish to save into on the left of the 
display. 

2. Then focus on the Snapshots list on the right of the 
display. 

3. Select the SAVE button to save all the current settings 
into a new snapshot (full snapshot). 

A new snapshot appears at the bottom of the list. It is given a 
default name (e.g. snapshot0011), and date and time stamped: 

Note that all settings are always saved into a snapshot 
regardless of SNAP ISO selections. 

Note that the SAVE PARTIAL button saves a partial snapshot. 
Partial snapshots store selected routing crosspoints which are 
prepared from the Matrix display. See Page 73 for more details 
on partial snapshots. 
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Renaming a Snapshot 

To rename the snapshot: 

1. Select the snapshot to rename from the Snapshots list 
using the trackball: 

Click once to select all the existing text (white) or twice (black 
cursor) to modify the existing name. 

2. Enter a new name from the keyboard.  

3. When you have finished, press the Enter button on the 
keyboard to confirm the new name. 

4. Or, if you make a mistake or want to exit the naming 
mode without making any changes, press the Esc 
button on the keyboard. 
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Adding a Memo 

You may use the two Snapshot Memo lines to add memo 
information.  

1. Select the snapshot and then select a line in the 
Snapshot Memo box. 

A black cursor appears. 

2. You may now type to enter your information from the 
keyboard. 

The first and second memo lines appear beside the snapshot 
name in the Snapshots list. You can enter as many characters 
as you wish in each line; the list will automatically resize to fit. 

If you cannot enter any memo text, check that the snapshot is 
not protected. 

If you right-click the snapshot memo, then you can use the 
Copy and Paste options to copy memo text to another 
snapshot: 

You can also drag and drop the Memo columns using the 
mouse to change their position on the display. 
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Updating an Existing Snapshot 

Updating a snapshot overwrites the settings within the snapshot 
memory, so take care to select the correct snapshot when using 
this function. 

1. Select the folder and snapshot you wish to update 

The selected snapshot is highlighted in black: 

2. Right-click and select UPDATE to update the snapshot 
with the current settings. 

Selecting UPDATE overwrites the selected snapshot as 
indicated by the new date and time stamp. 

Deleting a Snapshot 

Deleting a snapshot removes the snapshot from the Control 
System, so take care to select the correct snapshot when using 
this function. 

1. Select the folder and snapshot you wish to delete. 

The selected snapshot is highlighted in black: 

2. Right-click and select DELETE. 

3. Select OK to confirm the operation: 

 

 

 



 
Productions and Snapshots 
Snapshots  

140/ 221 V4.14/3 mxGUI  User Guide for Nova73 

Protecting a Snapshot 

A protected snapshot cannot be updated or deleted. Always 
protect important snapshots as this will prevent accidentally 
overwriting a snapshot using UPDATE or deleting the snapshot 
using DELETE. 

1. Select the snapshot you wish to protect. 

The selected snapshot is highlighted in black: 

2. Right-click and select PROTECT. 

A padlock icon appears to show that the snapshot is now write 
protected:  

Importing and Exporting Snapshots 

Individual snapshots can be transferred between the mxGUI 
computer and an online Nova73 system using the File Transfer 
display. See Page 34 for details. 
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Backup Snapshots 

Backup snapshots may be used to provide levels of undo when 
running mxGUI.  

When active, a backup snapshot is automatically stored by the 
system every n seconds. You can set how often the backup 
snapshots are stored from the System Settings display, see 
Page 189. For example, you may set the backup snapshot 
interval to every 5 minutes. You can also set how many backup 
snapshots are stored before the first is overwritten. For 
example, you might limit the number to 12 backup snapshots 
giving yourself a 1 hour „undo‟ window. 

All the backup snapshots for a particular production are stored 
within a special folder named „BACKUP FOLDER‟; this Folder 
cannot be deleted. However, you can rename the folder if you 
wish to keep the last set of backup snapshots. After the next 
backup snapshot interval, a new BACKUP FOLDER will be 
created. 

To revert to the latest backup snapshot: 

1. Select the BACKUP folder on the left of the display 
either using the trackball or navigation controls: 

The Snapshots list now shows all the backup snapshots, each 
one time and date stamped. 

2. Select the latest backup snapshot from the list. 

3. Right-click and select LOAD to complete the operation. 

The system updates to the backup snapshot settings. 

If your mistake was made longer than 5 minutes ago, then you 
may need to load an earlier backup snapshot to undo your 
error. 

Note that the backup snapshot time interval and the number of 
backup snapshots are set from the System Settings display, 
see page 189 for details. To disable the backup snapshot 
system, set the number of backup snapshots to 0. You may 
wish to do this during a live show as each automatic save 
causes a brief interruption to the system. 
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Chapter 8: Signal Containers 

Introduction 

The Signal Container displays can be used to handle multi-
channel connections within any HD Core system, including the 
Nova73 routing matrix and mc2 mixing consoles.  

For example, at the Football World Cup a central Nova73 matrix 
may be used to handle the connections between each 
commentator location and the broadcaster‟s studio at the IBC. 
Each „link‟ requires both incoming and outgoing connections 
such as the commentators microphone, earpiece feed, guide 
commentary, etc. And, the routing of these „links‟ will vary day 
by day as different games are broadcast from different venue 
locations. mxGUI‟s signal containers provide an elegant way of 
managing these related connections: 

Signal containers are configured and controlled from mxGUI. 
Note that the Signal Container displays are not available from 
the mc2 console GUI. 

A unique feature is that multi-user feedback is provided to and 
from the routing matrix. For example, a connection updated 
from one mxGUI will be visible to other mxGUI users allowing 
everyone connected to the same control system to access and 
view routing changes: 

In addition, each mxGUI workstation may be configured with 
monitoring, metering and a talkback microphone so that users 
can line check individual sources and destinations. 
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Concepts 

Containers 

Signal containers are used to group signals, so that multi-
channel crosspoint connections can be made in one operation.  

For example, in our Football World Cup model, we would create 
containers for each commentator location and for the 
corresponding feeds at the broadcaster‟s studio. Each container 
may hold a mixture of sources and destinations, such that the 
operator can make multiple connections simply by routing one 
container to another – e.g. “Commentator Munich” to “IBC”. 

Layers 

Within each container, sources and destinations are organised 
into layers. When a connection is made, the corresponding 
layers are routed to each other: 

 

Up to 128 layers may be defined, and each layer may hold a 
source and/or a destination. For example, the microphone of 
our commentator and his return feed could be designated as 
the source and destination within the same layer: 
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Source and Destination Containers 

A container can hold both sources and destinations. However, 
you must define whether a container is itself a source or 
destination. Think of this as the group of signals which you are 
connecting to and from. In our example, the “Commentator 
Munich” is a source container, and the “IBC” is a destination 
container. 

You can connect any source container to any destination 
container. However, you cannot connect containers of the same 
type – for example, a source container to another source 
container. 

Connection Types 

When you connect a source and destination container, you can 
also choose one of three connection types: 

 Bidirectional connection. 

 One-way connection (sources to destinations) 

 One-way connection (destinations from sources) 

 

Note that the connection type is applied to ALL layers within the 
container. You cannot apply a bidirectional connection to some 
layers and a one-way connection to others.  
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However, not all layers contain both a source and a destination. 
For example, if layer 2 of Container 1 has no destination, then 
the outcome will result in a one-way connection even if a 
bidirectional connection type is applied: 

 

Pending and Active Connections 

When you make a connection, first you prepare it and then 
make it active. This allows you to prepare several container 
connections in advance, and then action them all in one 
operation. It also provides a level of confirmation before routes 
are changed to safeguard against operator error. 

Prepared connections are shown as “Pending”. They are 
actioned using the Take button, and once the routes are made, 
the connection state updates to “Active”: 
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The Signal Container Configuration 

Signal containers are stored as part of the system configuration. 

Online Operation 

When running online, all data is being read from and stored to 
the Nova73‟s Control System. 

If a number of mxGUI computers are connected to the same 
control system, then changes made by one user will update the 
configuration and be broadcast to other users. This enables full 
control of the signal container configuration from any network 
location. 

Offline Operation 

When running offline all data is stored on the local mxGUI 
control system.  

In order to prepare signal containers offline, it is important that 
the configuration stored on the Local Control System matches 
that of the final Nova73 system. 

The best way to achieve this is to import the configuration from 
the system you are going to work on. Once imported, you can 
be sure that the containers you create will load in full on the 
Nova73 system.  

For a fail safe approach these are the steps you should follow: 

 Transfer the Nova73 configuration to the mxGUI Shared 
Folder. 

 Change the configuration of the Local Control System.  

This ensures that the configuration data running on mxGUI 
matches that of the actual Nova73 system. You will need to 
cold start mxGUI for the new configuration to take affect. 

 Prepare the new settings offline and save any changes. 

 Transfer the configuration back to the Nova73. 

 Cold start the Nova73 control system. 

This is a similar procedure to preparing a production offline, see 
Page 38. 
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Local Options 

Although the signal container configuration is stored on the 
control system, there are a number of local options which allow 
mxGUI to be customised for each user. Please contact your 
local Lawo representative or email service@Lawo.de for more 
information. The main options include: 

Signal Parameter Control 

Each mxGUI workstation may be configured with monitoring, 
metering and a talkback feed so that users can line check 
individual sources and destinations.  

The access to this option, and the audio sources and/or 
destinations for the monitoring, metering and talkback must be 
configured within local configuration files. 

Once configured, each operator can monitor any individual 
signal and send talkback to any destination. They can also 
adjust the level (the digital I/O matrix gain) of any signal. 

Scopes 

A scope can be used to filter the container groups accessible 
from each mxGUI workstation. This enables the workstation to 
be customised for its application.  

Using our World Cup Football mode, a scope could be used so 
that a workstation located in Venue 1 can only see and edit 
container definitions and connections between Venue 1 and the 
IBC. In addition, a number of different scopes may be defined 
within the IBC workstation so that the user can filter out 
unwanted venues for a particular transmission.  

Once configured, users can change between the scopes from 
the Scope menu. See Page 185 for more details. 

Suppressed Pages 

To customise each workstation for different applications, certain 
features of the programme may be disabled by suppressing 
pages within the GUI. As a result you may find that you do not 
have access to all the features or pages covered in this user 
guide. For more details, please contact your system 
administrator. 

 

mailto:service@Lawo.de
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The Signal Container Displays 

Three displays are available from the Page menu: 

 Signal Container Configuration – defines source and 
destination containers from signals within the routing 
matrix. 

 Signal Container Live – view and make connections 
between source and destination containers. 

 Signal Container Presets – defines presets which can 
be used to save and recall groups of container 
connections. 

At the top of each display, a drop-down menu provides access 
to Container scope settings. A scope can be used to filter the 
container groups accessible from each mxGUI workstation. This 
enables the workstation to be customised for its application.  

Within each display, you can resize the operating areas by 
clicking and dragging on the grey separator bars. Some areas 
may be larger than the available window space. If this is the 
case, then use the left/right or up/down scroll bars to view all 
the information.  

In addition, two pop-up windows can be opened from the 
Window menu: 

 Signal Container Parameters – access to monitoring, 
level control and talkback for each signal assigned to the 
selected source and destination container. 

 Signal Container Presets List – lists all presets 
defined within the Presets display. 

These pop-up windows can be positioned anywhere, resized or 
minimised when not needed. This allows them to be opened 
within any mxGUI display. 
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The Signal Container Configuration Display 

The Configuration display contains four areas which are used 
to define source and destination containers: 

 

 Container List – a list of all signal containers defined 
within the configuration. 

 Container Details – the properties of the selected 
container. 

 Source Signals/Destination Signals – the available 
router signals. Any of these signals may be assigned to 
a container layer. This list is determined by the Signal 
List configuration (defined by AdminHD). 

 Contained Sources/Container Destinations – the 
sources and destinations which have been assigned to 
each layer of the selected container. 
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The Signal Container Live Display 

The Live display is used to make connections between source 
and destination containers.  

 Container Connections – a list of all the container 
connections made by mxGUI. Each connection may be 
either bidirectional or one-way, and its state will be 
either Active (the connection is live within the router) or 
Pending. 

 Source Containers/Destination Containers – the 
available source and destination containers as defined 
within the Configuration display.  

Connections are prepared by selecting a source and destination 
container, and then clicking on one of the Connection Type 
Buttons in the middle of the display – the connection state is 
shown as Pending. 

You may prepare a number of connections and disconnections 
by adding each one to the Container Connections list. 

To action the pending connections, click on the Take button at 
the top right of the display – the connection states update to 
Active. 
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The Signal Container Presets Display 

In order to save and recall groups of container connections, a 
third display may be used to define presets. For example, a 
preset could store all the container connections you require to 
transmit a particular programme or configure a particular setup.  

The Presets display is divided into four main areas: 

 Preset List – a list of all presets defined within the 
configuration.  

 Preset Details – the properties of the selected preset.  

 Connections – a list of the connections stored within 
the selected preset. 

 Source Containers/Destination Containers – the 
available source and destination containers. 

You can add connections into a preset by preparing the 
connection or disconnection as you would on the Live display, 
and then saving the preset.  
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Signal Container Configuration 

This section deals with the Signal Container Configuration 
display in more detail: 

The Configuration display is used to define the source and 
destination containers. Each container is given a unique ID 
name and designated to be either a source or destination 
container. Signals may then be added to each container layer 
from the Source and Destination Signal lists. 

Remember that when a connection between containers is 
made, the corresponding source and destination layers will be 
routed to each other: 

 

Using our World Cup Football model we are going to build a 
simple example, where we define a source container and a 
destination container. In our example, the source container 
represents a commentator position and the destination 
container represents the broadcaster station at the IBC. 
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Defining a New Signal Container 

To define a new container: 

1. Select “Page -> Signal Container ->  Signal Container 
Configuration” to open the configuration display: 

2. Click on the New button below the Container List. 

A new empty container is created with a default ID Name - in 
our example, Container_1784: 

The new container has 128 empty source and destination 
layers.  
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3. Edit the Container Details by clicking and typing within 
each field: 

Source/Destination Container – select Source or Destination 
Container from the drop-down menu. In our example, the 
commentator position is a source container and the broadcaster 
station is a destination container.  

ID Name – this is the reference name for the container. The ID 
Name MUST be unique. In our example, we will keep the 
default name of Container_1784. 

Group Name – use this name to help identify related 
containers. For example, you could enter Venue 1 for all 
containers relating to a particular location. 

Note that the group name can be used to filter containers via 
the Scope functionality described on Page 185. 

Label – this is the user label for the container. In our example, 
we will label the source container as Comm Pos1 and the 
destination container as Broadcaster1. 

Description – enter a description of the container here. 

Info – enter any additional notes here. 

Note that you MUST enter a valid ID Name for each container. 
All other fields are optional. However we strongly recommend 
that you enter a Group Name and Label as these fields will help 
identify the containers on the Live and Presets displays. 

When viewing containers within other pages, you can choose to 
sort them by ID name, Group name or Label. 
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4. Next, assign the individual source and destination 
signals to each layer of the container as follows: 

First click to select the source you wish to assign from the 
Source Signals list at the top of the display. 

Then drag and drop the source onto a container layer within the 
Contained Sources area: 

5. Repeat for each source and destination you wish to 
assign: 
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In our example, we have assigned sources and destinations to 
container layers 1 and 2. This will result in the container 
definition shown below: 

 

 

 

 

 

 

 

 

You can drag and drop consecutive signals in one operation as 
follows: 

 Click to select the first signal of the group. 

 Hold down SHIFT on your keyboard and select the last 
signal of the group. 

A group of signals is selected (highlighted in black). 

 Release the SHIFT button but WITHOUT releasing the 
mouse button, drag the signals onto the first container 
layer: 

 Then release the mouse button to drop the signals. 

The selected signals are assigned to consecutive container 
layers. 
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6.  If you wish to remove an assignment, then right-click on 
the container layer and select Delete signal: 

7. If you wish to replace an assignment, then drag and 
drop the new signal on top of the existing assignment. 

Note that each router signal is displayed with the following 
information: 

Signal name - this is the system name, set by the AdminHD 
configuration, and normally used to describe the physical 
location. 

Group name - this is the group name, set by AdminHD. 

Label – this is the user label which can be modified from the 
Signal List display or from AdminHD‟s Connect Manager. 

HLSD (High Level Signal Definition) – this is the system 
address set by AdminHD. 
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8. Once you have assigned your container layers, save the 
container definition by clicking on the Save button. 

The container is added to the Container List and the Edit 
mode cancels. In addition, you will see the text “New container 
successfully created” in the status bar at the bottom of the 
display:  

 

The container has now been saved to the system configuration.  

If you are running online, then this container will be visible to all 
users. (Note that if a workstation has been configured with 
scopes, then the scope may filter out some containers. See 
Page 185 for details.) 

9. Repeat to define each container for the configuration.  

Each time you save the container definition, the container is 
added to the system configuration. 
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Interrogating a Signal Container 

Below is a typical example of a “real world” configuration with 
multiple containers. 

1. At any time, you can interrogate a container by selecting 
it from the Container List on the left of the display. 

The Details and Layer definitions for the selected container are 
displayed accordingly: 
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Auto Select Signal 

To help locate signals within a complex configuration, you can 
enable the Auto select signal option at the bottom of the 
display: 

 

1. Enable the Auto select signal checkbox. 

2. Select an assigned Layer from either the Contained 
Sources or Contained Destinations lists. 

The Source Signals or Destination Signals list automatically 
scrolls to reveal the selected source or destination. 
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Editing a Signal Container 

1. Select the container from the Container List. 

2. Click on the Edit button. 

The Edit button turns dark grey showing that it is enabled: 

3. You can now update any of the details, or drag and drop 
new sources or destinations into the container layers. 

4. To save your changes, click on the Save button. Or to 
cancel without saving, click on Cancel. 

If the save is successful, then you will see the text “Container 
successfully edited” appear in the status bar. 

Note that you cannot save a container with the same ID Name 
as an existing container. If you attempt to do so, then the save 
will fail and an error message will appear in the status bar. 
Make sure you enter a unique ID name and then save the 
container definition. 

Deleting a Signal Container 

1. Select the container from the Container List. 

2. Click on Delete. 

A confirmation pop-up will ask you to confirm the delete. 

Note that when you delete a container, it is deleted from the 
system configuration. If there are other users connected to the 
same control system, then the deletion will affect all users. 

3. If you are sure you want to delete the selected 
container, click on OK. 

The container definition is removed from the configuration. 
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Signal Container Live 

The Signal Container Live display is used to make 
connections between source and destination containers. It can 
also be used to access the signal parameters sub window. 

1. Select “Page -> Signal Container ->  Signal Container 
Live” to open the display: 

 

If you have already made some connections, they will be shown 
within the Container Connections area.  

Note that this area always displays all active container 
connections made within the routing matrix. Therefore, any 
active container connections made by other mxGUI users will 
be displayed. And, if scope is enabled, the scope is not applied 
to the Container Connections list. See Page 185 for more 
details on scope. 
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Making a Connection 

When using signal containers, first you prepare the connection 
and then make it active. This allows you to prepare several 
container connections in advance, and then action them all in 
one operation.  

 To prepare a new connection: 

1. Select the source and the destination container you wish 
to connect from the lower half of the display. 

2. Then select the type of connection you want to make by 
clicking on one of the Connection Type Buttons in the 
centre of the display. For our example, click on the 
bidirectional button. 

The connection is added to the Connections List in the upper 
half of the display: 

 

Note that a bidirectional connection is shown as two separate 
one-way connections. This allows you to remove one of the 
directions if you wish. 

Note also that the state of the connections is shown as 
Pending. A Pending connection is prepared but is NOT yet live 
within the routing matrix. 
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To make the Pending connections active: 

3. Click on the Take button at the top right of the display. 

The container connections are now made within the routing 
matrix, and the state updates to Active: 

 

If each container is defined with two source and two destination 
layers, then the diagram below illustrates the connections 
made: 
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Removing a Connection (Disconnect) 

To remove a connection, first prepare the disconnect and then 
make it active as follows: 

1. Select the connection(s) you wish to remove. 

Use the SHIFT or CTRL buttons on your keyboard to select 
multiple connections. 

2. Click on the Disconnect button. 

The disconnections are added to the Connections List as 
Pending: 

 

The original connections remain in the list as Active, as we 
have not yet actioned the disconnect within the matrix. The GUI 
displays disconnections as ----X--->    

To complete the disconnection: 

3. Click on the Take button at the top right of the display. 

A confirmation pop-up appears warning that existing connects 
will be affected by the Take operation: 

4. Click on OK to confirm. 

The pending disconnections are actioned within the routing 
matrix, and the Active connections are removed from the list. 

Note that you can only disconnect container connections if both 
sides of the connection are within your scope. See Page 185 for 
details on using scopes. 
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Removing a Pending Connection 

If there is pending connection (or disconnection) which you 
don‟t wish to make active, then you will need to remove it from 
the Connection List before you click on the Take button. 

To remove a pending connection: 

1. Select the connections (or disconnections) you wish to 
remove: 

 

2. And click on the Disconnect button. 

The Pending connections (or disconnections) are removed 
from the Container Connections list. 
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Selecting Multiple Connections 

To help deal with multiple connections you can select a range 
as follows: 

1. Click on the first connection. 

2. Press and hold the SHIFT button on your keyboard. 

3. Click on the last connection.  

All connections within the range are selected: 

To select non-consecutive connections: 

1. Click on a connection. 

2. Press and hold the CTRL button on your keyboard. 

3. Click on the other connections you wish to select. 

All connections selected while CTRL is active are selected: 
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The Container Connections List 

This list shows the following information for each connection: 

 Preset ID – the ID name of a preset if a preset has been 
used to recall the connection. 

 Source ID name – the ID Name of the source container 
as defined within the Container Details on the 
Configuration display. 

 Source group name – the Group Name of the source 
container as defined on the Configuration display. 

 Source label – the Label of the source container as 
defined on the Configuration display. 

 Connection label – here you can enter a label to help 
identify connections: 

1. Click on the connection anywhere within the Connection 
label field – a cursor will appear. 

2. Type in the connection label: 

If you right-click while editing the Connection label you will find 
a number of tools to help copy and paste the text elsewhere. 

 Mode - this field describes the direction of the 
connection, and whether it is a connect or disconnect: 

o --------->  Connect 

o ----X--->    Disconnect 
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 State – this field describes the state of each connection: 

o Active – the connection is live within the router. 

o Pending – the connection or disconnection has 
been prepared but is not yet live. 

 Destination ID name – the ID Name of the destination 
container as defined on the Configuration display. 

 Destination group name – the Group Name of the 
destination container as defined on the Configuration 
display. 

 Destination label – the Label of the destination 
container as defined on the Configuration display. 

The Source and Destination Containers List 

Here you will see the ID Name, Group Name and Label for 
each container defined within the configuration: 

Interrogating Signals 

You can check which individual signals are assigned to a 
container as follows: 

1. Click on the arrow beside the container ID name. 

You will see two subdirectories containing source and 
destination signals. 

If the container only holds source signals then the Destination 
signals subdirectory does not appear, and vice versa. 

2. Click on the arrow to open each subdirectory. 

A list of individual signals appears: 
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Sorting the Lists 

You can reorder the Connections, Sources or Destinations lists 
by clicking on a field title. 

1. For example, to sort the Connections list by direction, 
click on Mode.  

2. Or, to separate Active and Pending connections, click on 
State. 

An arrow beside the field title indicates the current selection: 

Note that if you sort the Source or Destination Container lists 
while the individual signal layers are visible, then the layers are 
not sorted and always appear in the order: layer 1, layer 2, etc: 
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Auto Select Containers 

When this option is enabled, the selected source and 
destination container automatically follows the selected 
connection. For example: 

1. Enable the Auto select containers checkbox. 

2. Select a connection – in our example, IBC to ORF TV A. 

The Source and Destination containers are automatically 
highlighted within the container lists: 
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Signal Parameters 

In addition to making connections, the Signal Container 
displays can also be used to line check and adjust the matrix 
level of individual signals. 

To make full use of this facility, a stereo monitor output, meter 
feed and talkback mic return must be configured within the local 
configuration files on your mxGUI workstation. You can find 
more information in the “mxGUI Workstation – Local 
Configuration” guide or contact your system administrator. 

Once configured, each operator can monitor any individual 
signal and send talkback to any destination to help line check 
connections within a container. In addition, mxGUI can adjust 
the level (the digital I/O matrix gain) of any signal. 

The Signal Parameters Window 

To access the signal parameters for a connection: 

1. Select either a connection, or a Source and Destination 
Container, from the Signal Containers Live display. 

2. Right-click and select the Show parameters option. 

A pop-up window appears. 

3. At the top of the pop-up window make sure that the 
“View -> Selection” option is selected: 

In this mode, the pop-up shows signal parameters for the 
selected source container (on the left) and destination container 
(on the right). 

Note that you can also access the signal parameters pop-up 
from any display, by selecting “Window -> Signal Container 
Parameters” from the mxGUI main menus. 

The appearance of the signal parameters window is defined by 
your local mxGUI configuration options. You may be able to 
view all 128 container layers by scrolling the window, or you 
may be limited to a certain view. Another option is to only view 
container layers which have a signal assigned.  

Irrespective of your „view‟, you can resize and position the 
signal parameters window in the usual manner. 

 

 



 
Signal Containers 
Signal Parameters  

mxGUI User Guide for Nova73 V4.14/3 173/ 221 

Adjusting Signal Parameters 

 

The upper fields are for information purposes only and show: 

 Container – displays the ID Name of the container. 

 Layer – displays the layer number. 

 Source Signal – displays the Group Name and Signal 
Name of the assigned source or destination. 

Note that for destinations, the name of the connected source is 
also displayed (in grey). As sources may be connected to 
several destinations, the dest. Signal field below each source 
is left blank. 

The lower fields are active and may be used as follows: 

1. Click on the Mon 1 or Mon 2 buttons to route the source 
or destination signal to the left or right mxGUI monitor 
outputs. This stereo output is configured within the local 
mxGUI configuration. 

2. Adjust the Level field to adjust the signal level within the 
matrix.  

3. For a destination, click on the TB button to route the 
mxGUI talkback source to the destination. This mono 
talkback source is configured within the local mxGUI 
configuration. 

4. When you have finished, click on the red circle, at the 
top right, to close the signal parameters window. 
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The Custom Container 

At the top of the signal parameters window, the View menu 
provides access to two options: 

 “View -> Selection” -  shows signal parameters for the 
selected source and destination containers: 

 

 “View -> Custom” -  shows signal parameters for a 
custom container: 

 

The Custom container can be used to quickly access problem 
signals during a live broadcast. For example, create a source 
and/or destination container for any problem signals, and define 
these as your custom container (see next page). By changing 
view, as shown above, you can quickly access their signal 
parameters. 
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To assign the custom source and destination container: 

1. Return to the Signal Containers Live display and select 
a Source Container from the lower half of the display. 

2. Right-click and choose the Select as Custom 
Container option: 

3. Repeat to select a custom Destination Container. 
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Signal Containers Presets 

Presets may be used to save and recall groups of container 
connections. For example, a preset could store all the container 
connections you require to transmit a particular programme or 
configure a particular setup.  

Presets are defined from the Presets display and recalled using 
the Presets List pop-up window. This allows presets to be 
recalled from any mxGUI display. 

1. Select “Page -> Signal Container ->  Signal Container 
Presets”: 

If you have already defined some presets, they will be shown 
within the Preset List on the left of the display. 

2. Select a preset and the connections stored within it are 
displayed in the Connections area: 
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Defining a New Preset 

1. Click on the New button below the Preset List. 

A new empty preset appears with a default ID – in our example, 
Preset_76: 

 

2. Edit the Preset Details by clicking and typing within 
each field: 

 Preset ID – this is the reference name for the preset. 
The Preset ID MUST be unique. In our example, we 
have named the preset Match #1. 

 Title – this is the user title for the preset. In our example, 
we have entered Group A 1st / Group B 1st - this preset 
will store all the connections required for the first game 
of the World Cup tournament! 

 Description – enter a description of the preset here. 

Note that you MUST enter a valid Preset ID. All other fields are 
optional. However we strongly recommend that you enter a Title 
as this will help identify the preset later. 
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3. Next, add the container connections which you wish to 
store within the preset. 

Follow the same method you used earlier on the Live display: 

 First select the source and the destination container you 
wish to connect from the lower half of the display. 

 Then select the type of connection you want to make by 
clicking on one of the Connection Type Buttons.  

The connection is added to the Connections list. 

4. Repeat for each connection you wish to store: 

 

5. If you wish to remove a connection before saving the 
preset, then select the connection and click on 
Disconnect. 
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6. Once you have added all the connections you wish to 
store, save the preset by clicking on Save. 

The preset is added to the Preset List on the left of the display 
and the Edit mode cancels: 

 

The preset has now been saved to the system configuration. 

If you are running online, then this preset will be visible to all 
users. (Note that if a workstation has been configured with 
scopes, then the scope may filter out some containers. See 
Page 185 for details.) 

7. Repeat to define each preset for the configuration.  

Each time you save the preset definition, the preset is added to 
the system configuration. 
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Interrogating and Editing a Preset 

You can interrogate or edit an existing preset in the same way 
you dealt with containers earlier from the Configuration 
display: 

To interrogate the contents of a preset: 

1. Select the preset from the Preset List. 

A list of all the connections stored appears, and the Preset 
Details update accordingly. 

To edit the preset: 

2. Click on the Edit button: 

The Edit button turns dark grey. 

3. You can now update any of the Preset Details, or add 
or remove connections from the Connections list. 

4. To save your changes, click on the Save button. Or to 
cancel without saving, click on Cancel. 

Note that you cannot save a preset with the same ID as an 
existing preset. If you attempt to do so, then the save will fail 
and an error message will appear in the status bar. Make sure 
you enter a unique ID name and then save the preset. 

Deleting a Preset 

1. To delete a preset from the configuration, select it from 
the Presets List on the left of the display. 

2. Then click on Delete. 

A confirmation pop-up will appear asking you to confirm the 
delete. 

Note that when you delete a preset, it is deleted from the 
system configuration. If there are other users connected to the 
same control system, then the deletion will affect all users. 

3. If you are sure you want to delete the selected preset, 
click on OK. 

The preset is removed from the configuration. 
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Recalling a Preset 

Having defined a preset it can be recalled from the Presets List 
pop-up window while viewing the Signal Containers Live 
display: 

1. Select “Page -> Signal Container ->  Signal Container 
Live”. 

2. Then select “Window -> Signal Containers Presets 
List” from the mxGUI main menus. 

The Presets List pop-up appears on top of the Live display 
and lists all presets saved within the system configuration: 

 

You can resize and position the Preset List window in the 
usual manner. 
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3. To recall a preset, select it and click on Prepare 
connect. 

A C is added beside the preset ID in the pop-up window, and all 
connections stored within the preset are added to the 
Connections List of the Live display: 

 

Note that the connections recalled from a preset are always 
added as Pending.  

4. Make the connections live by clicking on the Take button 
at the top right of the Live display: 
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Whenever connections are recalled using a preset, you will see 
the preset ID name appear in the Preset ID column – in our 
example, Match #1. 

Note that you can prepare several presets, and combine them 
with manual connections, before making all Pending 
connections Active in one operation from the Take button. 

5. When you have finished, click on the red circle, at the 
top right, to close the Presets List window. 

Disconnecting a Preset 

A preset may only store connections. Therefore, to disconnect 
the active connections stored within a preset, use the Prepare 
Disconnect function as follows: 

1. Open the Presets List pop-up window as before. 

2. Select the preset and click on Prepare Disconnect. 

A D is added beside the preset ID in the pop-up window, and 
the disconnections are added to the Connections List as 
Pending: 

 

3. Click on the Take button to action the disconnects. 
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Cancelling a Preset 

You can remove any Pending connections (or disconnections) 
recalled by a preset as follows: 

1. Open the Presets List pop-up window as before. 

2. Select the preset and click on Cancel. 

Any pending connections which had been recalled from the 
preset are removed from the Live display. 
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Scopes 

A scope can be used to filter the container groups accessible 
from each mxGUI workstation. This enables the workstation to 
be customised for its application.  

Using our World Cup Football mode, a scope could be used so 
that a workstation located in Venue 1 can only see and edit 
container definitions and connections between Venue 1 and the 
IBC. In addition, a number of different scopes may be defined 
within the IBC workstation so that the user can filter out 
unwanted venues for a particular transmission.  

Scopes must be pre-configured within the local configuration 
files of the mxGUI workstation. For details please refer to the 
“mxGUI Workstation – Local Configuration” guide. 

If scopes are configured on your mxGUI, then you will be able 
to select a Container scope from a drop-down menu at the top 
of each Signal Containers display: 

 

Having made your selection, any container groups filtered by 
the scope will be removed from all three operational displays – 
Configuration, Live and Presets – depending on the scope‟s 
particular definition. 

Note that if scopes are not defined within your configuration, 
then the only available mode of operation is No Scope. 
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Chapter 9: System Configuration 

Introduction 

This chapter deals with the user options provided by the 
System Settings and Custom Functions displays. 

Note that the System Settings display contains all settings for 
any mc2 system. The result is that many settings are not 
relevant for stand-alone Nova73 systems. For more information 
on mc2 console features, please refer to the mc266 Operators 
Manual. 
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The System Settings Display 

The System Settings display configures a number of user 
options: 

1. Select Page -> System -> System Settings to view this 
display: 

On the left you will see a list of topics. 

2. Select a topic – for example, Global. 

The right hand side of the display updates to show a list of 
options within the selected topic – for example, Isolate, Mute, 
Track self assign, etc. 

3. Depending on the option it can be modified as follows: 

 Checkbox on/off (e.g. Isolate) - select the checkbox 
beside the option. 

A green cross appears when the option is enabled – for 
example, Isolate is ON. 

 Drop-down selections (e.g. Surround format) – select 
an option from the drop-down list.  

 Numeric Entries (e.g. Backup snap max.) – some 
options require a number to be entered. You can click 
on the existing entry and type in a value; or click on the 
up/down arrows beside the number to increment or 
decrement its value. 

Note that if you hover the trackball above each option name, 
you will see a „Tool Tip‟. This is a helpful description which acts 
as a brief reminder of the option‟s function.  

Not all topics or options are relevant for a Nova73 system. 
Relevant options exist within the Global, Gui, Wordclock and 
mxDSP topics. 
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Global Options 

Select the Global Topic: 

 

The following options can be applied as follows: 

 Product Release and Control Software Versions 

The next fields are for display purposes only, and tell you the 
software versions running on your system. Note that there are 
two different releases, both important when reporting software 
versions to a service engineer: 

 Product Release Version – this is the release version 
of your product software. 

 Product Control Software Version – this is the release 
version of the control system software. 

 Data Memory Load 

This field is for display purposes only, and indicates the amount 
of used space on the user data card. 
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 Backup Snapshot Maximum 

This option sets the number of backup snapshots which will be 
automatically stored before the first backup snapshot is 
overwritten. The number may be adjusted from 0 to 1000. Enter 
0 to turn off the backup snapshots function. 

 Backup Snapshot Interval 

This option sets the time interval between backup snapshots, 
and may be adjusted from 60 seconds to 24 hours (86400s). 

 Prepare Cold Start 

This option sets whether the system will cold or warm start on 
the next power-on: 

 Prepare Coldstart (on) - the system will cold start. This 
means that no user data is loaded. Use this option if you 
wish to clear all user settings from the system. 

 Prepare Coldstart (off) - the system will warm start. 
This means that the system is restored with same 
settings as before the power off. 

Note that following a restart this option is always reset to off. 
This ensures that by default, warm start data is loaded at the 
end of every power-on or restart. 

 Set Internal Clock and Set Internal Date 

The next two options set the internal clock and date.  

Type in the time or date wish to set and then press Enter. 

A confirmation pop-up appears. 

Select OK to confirm. 

The new time or date is set. 

 Redundancy Takeover 

Use this option to force a manual takeover from the redundant 
control system (if fitted). 

A confirmation dialogue box appears: 

Select Yes to confirm or No to cancel the operation. 

Selecting Yes switches to the redundant Control System. 
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GUI Options 

Select the GUI Topic to set the following Graphical User 
Interface options: 

 Time Display 

At the top of every display a time is displayed. This may be the 
local time, in 24 hour clock, or timecode: 

 Local – displays the control system time in 24 hour 
clock. 

 Timecode - displays SMPTE timecode from your 
selected timecode reference. 

 Offset TC - displays SMPTE timecode + the Midnight 
offset. 

Note that only the Local setting applies to Nova73 systems. 
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Wordclock Options 

The Wordclock topic covers a range of options for selecting the 
internal operating frequency of the system and source priorities 
for incoming sync signals.  

Select the Word clock topic to set the following options: 

 Max Sample Rate 

This field displays the maximum internal sample rate as set by 
the system configuration.  

The maximum rate cannot be changed by the user but can be 
set to either 48kHz or 96kHz by the AdminHD configuration. 
Please refer to the “Nova73 Technical Manual” for details on 
AdminHD. 

Note that if the maximum sample rate is 96kHz, then the  
system may still operate at 48kHz by changing the Sample 
Rate option below. 

 Sample Rate 

This option selects the internal sample rate of the system. Make 
sure that your clock source matches this selection. 

When running at lower sample rates, you may select either 
48kHz or 44.1kHz operation; when running at higher sample 
rates, you may select 96kHz, 88.2kHz, 48kHz or 44.1kHz  
operation.  

Note that the option to run at higher or lower sample rates is 
made within the AdminHD configuration, and is displayed in the 
Max Sample Rate field described above. 
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 Source Priority 1 and 2 

These two options allow you to select the main and redundant 
clock source for the system. If sync is lost or a signal of an 
incorrect frequency appears on Source Priority 1, the system 
automatically switches to Source Priority 2. Similarly, if sync is 
lost on Source 2, the system automatically switches to internal 
sync. 

You can set each of the options to: 

 Input 1 – from the HD Core rear panel.  

 Input 2 – from the HD Core rear panel. 

 MultiCh - Multichannel Sync (this option depends on 
your system configuration) 

 Active Synchronization Source 

This option displays and sets the active sync source for the 
system:  

 Src Prio 1 – the input selected as Source Priority 1. 

 Src Prio 2 – the input selected as Source Priority 2. 

 Internal. 

If sync is lost or a signal of an incorrect frequency appears on 
Source Priority 1, the system automatically switches to Source 
Priority 2. Similarly, if sync is lost on Source 2, the system 
automatically switches to internal sync. 

 Return Mode 

This option activates a return mode so that the system will 
switch back to Source Priority 1 (or 2) when it returns. The 
system even checks whether the return sync is valid and will 
not switch until the sync source matches the chosen operating 
frequency. 

 Return Mode (On) - activates the return mode. 

 Return Mode (Off) - deactivates the return mode. 

To force the system to run on internal sync, deactivate the 
return mode and set the Active Source to Internal. 
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 Alarm when internal  

This option activates an alarm when the system is running on 
internal sync: 

 Alarm when internal (On) -  activates the alarm. 

 Alarm when internal (Off) -  deactivates the alarm. 

The alarm triggers on-screen Warning flag and illuminates the 
red LED on the front panel of the HD core router card. 

 External Sync Input Status  

The next five options are for display purposes only and show 
the status of the external and multi-channel sync signals.  

The example above shows that a valid Wordclock signal is 
connected to external inputs 1 and 2, and the Active 
Synchronisation Source is Src Prio 1 = Input 1.  
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mxDSP Options 

The mxDSP Topic provides options for the optional mxDSP 
card, see Page 101: 

The option determines whether mxDSP signals are affected by 
snapshot loads: 

 Isolate all mxDSP signals (on) – isolates all mxDSP 
signals so that they are not affected by a snapshot load. 
Use this option to protect the current mxDSP card 
settings. 

 Isolate all mxDSP signals (off) – settings will be reset 
by a snapshot load. Use this option if you wish to recall 
mxDSP settings from snapshots. 

Note that the same option can be selected using the Global 
Snapshot ISO MXDSP button on the Snapshots display, see 
Page 135. 
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Remote Options 

The Remote Topic provides options for the Lawo Remote App, 
see Chapter 10: 

The option determines whether the console may be controlled 
from a remote device running the Lawo Remote App: 

 Safe Mode (on) – access from remote devices is 
denied. Use this mode to prevent unauthorised control 
of the console. 

 Safe Mode (off) – the console may be controlled by a 
remote device running the Lawo Remote App. 
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The Custom Functions Display 

This display provides access to factory-configured custom 
functions so that users can reconfigure the console without 
assistance from Lawo. 

The functions configured from this display are stored as part of 
the system configuration, which means that any changes will 
affect all users. In addition, there are many powerful features. It 
is recommended that users have a good understanding of the 
system, are familiar with the programming of user buttons, and 
understand how to connect to the system via ftp or telnet. For 
more information, please refer to the Nova72 Technical Manual. 

1. Select Page -> System -> Custom Functions to view 
this display: 

The Functions column on the left lists the different types of 
function which can be configured. A brief description appears 
when you hover over each title.  

2. Select a function – e.g. Red Light – to interrogate any 
existing assignments. 

Each time you select a different function, the Assignments 
column updates. 

3. Select an Assignment to interrogate its Details. 

Above we can see that Lawo Remote App Panel 1, button 1 is 
assigned to a GPIO output; the function is named Red Light. 

The look of your display will depend on the assignments stored 
within the system configuration.  
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User Buttons 

Many functions listed on the Custom Functions display can be 
assigned to a user button operated from an iPhone, iPod or 
iPad running the Lawo Remote App, see Chapter 10. 

The panel index and button numbering for the first two panels is 
shown below:  

Up to four User Button panels may be configured. 

 

Warning 

Before changing the function of a user button, make sure that 
there is nothing assigned to it. Otherwise, the button will 
perform multiple operations! 

Be aware that factory-configured user functions do NOT appear 
in the Custom Functions list. If you wish to reprogramme 
these, then you should contact Lawo to remove the factory 
configuration first. 
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Creating a New Assignment 

Let‟s take the example of mapping an unused button to a GPIO 
output connected to a green light: 

1. Right-click on a function type and select New 
Assignment. 

A pop-up window appears listing the assignment details: 

2. Edit each field as follows: 

 Function Name and Description: the first two fields are for 
information purposes only and cannot be edited. They 
describe what the function does. 

 Assignment Name: Here you can enter a name for the 
assignment. In our example, we are going to name the 
assignment after its function – Green Light. 

 Description: Here you can enter a user description for your 
assignment if you wish. 

 Userbutton Type: This drop-down menu selects the panel 
for the button assignment. For a Nova73, only the Lawo 
Remote APP is relevant, so select this option. 

 Panel Index: This drop-down menu selects the panel 
number. 

 Userbutton Index: This field selects the button number you 
wish to assign. 
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In our example, we have selected button 3 on Panel 1: 

 Userbutton Scribble: If the selected user button has an 
accompanying scribble strip display, then you can enter the 
text to be displayed in this field. Up to 8 characters. 

Text will only be displayed if the button has a scribble strip such 
as the touch-screen buttons on the Lawo Remote App. 

Then enter the details for the GPO output: 

 GPO HLSD – this is the Lawo system address of the GPO 
which will be triggered. 

 GPO Mode – latching, momentary, pulse, etc. 

 GPO Time – for a pulsed relay. 

3. Once you are happy select OK. 

The assignment is made and you will see its name appear in 
the Assignments list: 

4. Repeat these steps to configure other custom functions. 

Note that as soon as you make or edit an assignment, the 
changes are written into the system‟s configuration data on the 
control system. Custom Functions are stored as part of the 
configuration and not in productions, and therefore affect all 
users of the system. 
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Editing an Assignment  

To edit an existing assignment: 

1. Select the Function and Assignment you wish to edit – 
for example, Play. 

2. Right-click and select Edit Assignment: 

The Edit Assignment pop-up window appears showing the 
current details of the assignment. 

3. Edit the fields and select OK to confirm the changes. 

Deleting an Assignment  

To delete an existing assignment: 

1. Select the Function and Assignment you wish to 
delete – for example, Play. 

2. Right-click and select Delete Assignment. 

3. Confirm by selecting OK. 

The assignment is deleted. 

Entering a HLSD Address 

Some functions require you to enter the Lawo system address 
(HLSD address) for a signal. You can copy and paste this 
address from the mx Routing display as follows: 

1. Open the mx Routing display and locate the signal. 

2. Right-click and select Show Source Parameters (or 
Show Destination Parameters): 

The Signal Parameters pop-up window appears. 
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3. Select the Device tab. 

4. Select the HLSD address field, right-click and select 
Copy to copy the address to the system clipboard: 

5. Now return to the Custom Functions display. 

6. Create a new function assignment, or edit an existing 
assignment – for example, a Static Connect: 

 

7. Right-click on the HLSD field and select Paste to paste 
the copied address. 
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Function Commands 

Each function type provides access to a different set of 
commands. Use the drop-down Command field at the bottom 
of the New/Edit Assignment window to view the available 
options. This section describes the functions in alphabetical 
order: 

Central User Button, GPI Outputs 

Maps user buttons to external relays (GPI Outputs). For each 
user button define the: 

 GPO HLSD – this is the Lawo system address of the 
GPO which will be triggered. 

 GPO Mode – latching, momentary, pulse, etc. 

 GPO Time – for a pulsed relay. 
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Central User Button, Routing Connect 

This function allows you to perform signal routing from a user 
button. Up to 28 connects/disconnects can be assigned to one 
User Button; you can create several instances of this template.  

 

You can copy the source and destination HLSD from the mx 
Routing display, see Page 200. Routes may be made to/from 
any source or destination including DSP channels. 

To create a disconnect, type DISCONNECT into the field for the 
Source HLSD.  

To secure the operation, you can define an Enable 
Userbutton. Once defined, you will need to hold down Enable 
while pressing the Connect user button in order to action the 
connects/disconnects. 

Note that the Enable and Routing Connect user buttons are 
not multi-touch capable, therefore do not assign them both to a 
touch-screen. 

Please ask for advice from Lawo staff if you wish to do so.  

Central User Button, Routing Toggle Connect 

This function is similar to above, but provides source on and 
source off states so that routes may toggle. Up to 16 
connects/disconnects can be assigned to one User Button; you 
can create several instances of this template.  
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Central User Button, Snapshot Load 

This function allows you to load a specific snapshot from a 
single user button press. You can make the operation more 
secure by defining an Unlock user button. This means that the 
operator must press and hold the Unlock button while pressing 
the Snapshot Load in order to recall the snapshot. 

Note that the Unlock and Snapshot Load user buttons are not 
multi-touch capable, therefore do not assign them both to a 
touch-screen. 

For each function, define the: 

 Snapshot Folder – the name of the Folder where the 
snapshot is stored. 

 Snapshot – the name of the Snapshot you wish to load. 

Note that you can define any snapshot from any folder within 
the active production. 

 Userbutton Type, Panel Index, etc. – the user button 
which will action the Snapshot Load. 

 Unlock Userbutton Type, Panel Index, etc. – the user 
button which will action the Unlock function. 

Note that if the Unlock user button is empty, then the 
Snapshot Load will action on a single press of the first user 
button. 
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GPI Input, Routing Connect 

This function allows you to perform signal routing from a GPI 
Input. Up to 16 connects/disconnects can be assigned to one 
input; you can create several instances of this template.  

 

You can copy the source and destination HLSD from the mx 
Routing display, see Page 200. Routes may be made to/from 
any source or destination including DSP channels. 

To create a disconnect, type DISCONNECT into the field for the 
Source HLSD.  
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Global isolate of SDI parameters 

SDI parameters are never stored by snapshots. From Version 
4.8.0.2 onwards, they are stored and recalled by productions. 
This function can be used to isolate all SDI parameters so that 
settings are not affected by a production load.  

This template should only be created once. If created several 
times, the last initialised one wins. 
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Snap Iso List 

This function allows you to isolate sources or destinations to 
prevent them being reset by snapshots, and/or from 
productions or the Signal List display. 

Up to 48 signals may be defined within each Snap Iso List 
assignment; you can create multiple assignments to isolate lots 
of signals.  

Within each Snap Iso List assignment, the Snap-iso Type can 
be: 

 Permanent – signals are not reset by snapshots or 
productions, and cannot be adjusted from the Signal 
List display. 

 User – signals are not reset by snapshots, but will be 
reset by productions and can be adjusted manually from 
the Signal List display. 

For each Snap Iso List assignment, enter the HLSD (Lawo 
system address) of the signals you wish to isolate. 

 

You can copy the signal HLSD from the mx Routing display, 
see Page 200. 
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Static Connect 

This function allows you to define a Static Connect by entering 
the HLSD (system address) for a Source and a Destination: 

 

You can copy the signal HLSD from the mx Routing display, 
see Page 200. 

A Static Connect is a routing crosspoint which will always be 
active. If it is disconnected by any means, for example by the 
console operator or by an external controller, the crosspoint is 
automatically remade. You might use this function to prevent 
vital crosspoints from being accidentally reset. 

Note that having defined a Static Connect, the only way to 
change or disconnect the crosspoint is to delete the Static 
Connect from the Custom Functions display. 
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T-Connect 

This function allows you to define a T-Connect by entering the 
HLSD (system address) for a Reference output and a 
Destination output: 

 

The Destination output always follows the Reference output. 
So, for example, if the source to the reference output is Sum 3, 
the destination output source is also Sum 3. You might use this 
function if you have several transmission feeds all requiring 
identical routing changes 
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Chapter 10: Lawo Remote App 

Overview 

The Lawo Remote App is a free App which allows you to recall 
snapshots and control user-defined functions remotely from an 
iPhone, iPod or iPad. 

From the Lawo Remote App you have access to the following: 

 Snapshots – load any Snapshot from any folder within 
the active Production. 

 User Buttons – a special page of buttons allow you to 
control user defined functions such as monitoring, GPI 
control, etc. The button assignments are made from the 
Custom Functions display and stored as part of the 
console configuration. 

Installing the Lawo Remote App 

The Lawo Remote App can be downloaded, for free, from the 
App store, and installed on an iPhone, iPod or iPad. Download 
and install the App on your device in the usual manner. 

Configuring the Network 

The remote device communicates with the console‟s control 
system via WLAN (Wireless Local Area Network).  

To use the Lawo Remote App you must have a properly 
configured wireless network access point and know the IP 
address of the Nova73 control system. There are several 
configuration options depending on your network infrastructure, 
so please consult your network administrator or refer to the 
technical document “TD_AccessPoint.iApp” for details. 

Once the wireless network access point is configured, you can 
find the IP address of the Nova73 control system from the 
Signal Settings display as follows: 
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1. Select Page -> Signals -> Settings to view this display. 

2. Select the System from the “system tree” on the lower 
left of the display: 

The IP address of the control system is displayed in the 
parameter area: 
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Enabling App Control 

To prevent unauthorised control of the console, remote access 
must be enabled from the console‟s System Settings display: 

1. Select Page -> System -> System Settings. 

2. Select the Remote Topic and make sure that the Safe 
Mode option is unchecked: 

The console may now be controlled from a Lawo Remote App 
device. 

There is no limit on the number of clients. However, if more 
than one device sets a parameter, the last change wins! 

Starting the Lawo Remote App 

1. On your device, open the Lawo Remote App. 

The Lawo Remote welcome page appears showing the status 
of the existing connection – in our example, “Not connected”. 

2. Touch the Bookmark icon at the top right of the display. 

The Bookmarks page opens listing all configured connections: 

The list will be empty if no connections have been configured. 
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Configuring a New Connection 

To configure a new connection: 

1. Select the New Bookmark icon at the lower right of the 
display. 

The „New Bookmark‟ page opens, and your new connection is 
automatically configured as an mc256: 

2. Touch each entry to edit the: 

 System Name – e.g. Studio A. This name is used for 
reference within the Lawo Remote App. 

 System Type – e.g. mc²66. Choose from the list of 
supported systems (opposite). The system type must 
match that of the system you wish to connect to. 

 Primary & Secondary Host – enter the IP address of 
the control system you wish to connect to. If you have a 
redundant control system, then you will need to enter 
the primary and secondary IP addresses. 

 Comment - enter a Comment if you wish. 
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3. When you have completed each field, touch 
Bookmarks to return to the Bookmarks page. 

The name of your new connection appears in the list. 

4. At any time you can edit an existing connection, by 
touching the Edit button at the lower left of the 
Bookmarks page. 
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Connecting to the System 

You can connect to any system configured within the 
Bookmarks page.  

Note that you may only connect to one system at a time.  

1. Open the Bookmarks page, and touch the arrow beside 
the name of the system you wish to connect to. 

The following confirmation dialogue appears: 

2. Touch Yes to continue. 

The device attempts to connect. If successful, the operational 
menus appear and the connection status, at the bottom of the 
display, updates to show the system name: 

If the connection fails, then an error will appear. Check the 
system type and IP settings from the Bookmarks page. Check 
that the iPhone, iPod or iPad is connected to the correct WLAN. 
If the connection still fails, then there is a problem with your 
network or its configuration. Please contact your network 
administrator for assistance. 
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Controlling Parameters 

The main operational menus appear once you have an active 
connection to the Nova73 system. 

Note that the Strip Control menu, shown in the screenshots 
below, is not relevant to a Nova73 system! 

Snapshots 

1. Select Snapshots to load a Snapshot from any folder 
within the active Production: 

2. Select the folder: 

3. Then select the snapshot followed by Load. 

The snapshot is loaded to the console. If any snapshot Filter 
Modes or SNAP ISO buttons are active, then these are applied. 

4. To return to the main menus, select Snapshots followed 
by the Lawo Remote button (top left). 

Note that you cannot save or update snapshots from the Lawo 
Remote App, or change production. 
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User Buttons 

1. Select User Buttons to access a special page of 
buttons designed for monitoring functions such as 
source selection and monitor level control: 

2. Touch a button to action its function. 

3. Touch one of the dots at the bottom of the page to 
access a different page of functions. 

4. To return to the main menus, select the Lawo Remote 
button (top left). 

Note that the Lawo Remote user buttons are assigned from the 
Custom Functions display, and therefore may vary when you 
connect to a different console. For details on how to change the 
assignments, please see Page 196. 
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Disconnecting from the System 

1. To disconnect from the system, select the Bookmarks 
icon at the top right of the display. 

The Bookmarks page re-opens and the connection status, at 
the bottom of the display, updates to “Not connected”: 
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Appendices 

Appendix A: Digital Output Settings 

For each digital output, sample rate conversion and dither are 
applied automatically depending on your choice of sample rate 
and word length from the Signal Settings display: 

The following table explains the results of each clock selection 
and word length combination: 

Clock Selection Word Length 
Selection 

SRC on/off  Dither Status 

System 24-bit SRC off Off (Truncate) 

System 20-bit SRC on Dither on 

System 16-bit SRC on Dither on 

    

44.1kHz 24-bit SRC on Off (Truncate) 

44.1kHz 20-bit SRC on Dither on 

44.1kHz 16-bit SRC on Dither on 

    

48kHz 24-bit SRC on Off (Truncate) 

48kHz 20-bit SRC on Dither on 

48kHz 16-bit SRC on Dither on 

    

Follow Input 24-bit SRC on Off (Truncate) 

Follow Input 20-bit SRC on Dither on 

Follow Input 16-bit SRC on Dither on 
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Index Directory 
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